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A proposito di questo manuale

Questo manuale permette di familiarizzare con l’ambiente di programma-
zione grafica e con le funzioni fondamentali di LabVIEW che permettono
di creare applicazioni di acquisizione dei dati e di controllo degli strumenti.

Il manuale contiene alcuni esercizi che insegnano come sviluppare applica-
zioni di base con LabVIEW. Questi esercizi possono essere completati in
breve tempo e aiutano a iniziare a lavorare con il programma.

Ogni esercizio comprende alcune illustrazioni che forniscono informazioni
sui concetti associati a quel passo specifico. Al termine di ogni capitolo è
incluso un riepilogo dei concetti principali esposti che permette di ripassa-
re quanto appreso.

Oltre a questo manuale, LabVIEW include il LabVIEW User Manual, il
LabVIEW Help, altri manuali di consultazione, note applicative ed esempi.
Selezionando l’opzione di installazione Complete, LabVIEW installerà
versioni PDF di tutti i manuali del programma, ai quali si può accedere
selezionando Help»Search the LabVIEW Bookshelf in LabVIEW.

Nota Per poter visualizzare i PDF è necessario aver installato Adobe Acrobat Reader con
Search and Accessibility 5.0.5 o versioni successive. Si faccia riferimento al sito Web Adobe
Systems Incorporated Web all’indirizzo www.adobe.com per scaricare Acrobat Reader.

Convenzioni
In questo manuale saranno utilizzate le seguenti convenzioni:

» Il simbolo » conduce a voci di menu nidificate e opzioni di finestre di dia-
logo per l’esecuzione di un’azione finale. La sequenza File»Page
Setup»Options indica l’apertura del menu File, la selezione della voce di
menu Page Setup e la selezione di Options dall’ultima finestra di dialogo.

Questa icona indica un suggerimento, che fornisce consigli utili.

Questa icona indica una nota, che fornisce informazioni importanti.
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grassetto

grassetto Il testo in grassetto indica le voci che occorre selezionare nel software,
come le voci di menu e le opzioni delle finestre di dialogo. Il testo in grassetto
indica inoltre i nomi dei parametri, dei controlli e dei pulsanti del pannello
frontale, delle finestre di dialogo e delle loro sezioni e i nomi delle palette.

corsivo Il testo in corsivo indica le variabili, l’enfasi, un riferimento incrociato o
un’introduzione a un concetto chiave. Questo tipo di carattere evidenzia
inoltre il testo che funge da segnaposto per una parola o un valore che deve
essere inserito.

monospaziato Questo tipo di carattere indica il testo o i caratteri che devono essere digitati
da tastiera, sezioni di codice, esempi di programmazione ed esempi di sin-
tassi. Questo tipo di carattere è inoltre utilizzato per i nomi propri delle
unità dei dischi, i percorsi, le directory, i programmi, i sottoprogrammi, le
subroutine, i nomi dei dispositivi, le funzioni, le operazioni, le variabili, i
nomi di file, le estensioni e gli estratti di codice.

monospaziato Questo tipo di carattere denota i messaggi e le risposte che il computer
visualizza automaticamente sullo schermo. Inoltre evidenzia le righe di co-
dice che sono diverse dagli altri esempi.
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1
Introduzione agli strumenti virtuali
di LabVIEW

I programmi di LabVIEW sono chiamati strumenti virtuali o VI (virtual
instrument), poiché nell’aspetto e nel funzionamento sono simili a stru-
menti fisici, come oscilloscopi e tester. LabVIEW contiene un ampio set di
strumenti per acquisire, analizzare, visualizzare e memorizzare i dati, oltre
a strumenti che aiutano nella risoluzione dei problemi del codice.

In LabVIEW si può creare un’interfaccia utente, detta anche pannello fron-
tale, con alcuni controlli e indicatori. I controlli sono le manopole (knob), i
pulsanti da premere (push button), i selettori (dial) e altri dispositivi di
input. Gli indicatori sono i grafici, i LED e altri display. Una volta creata
l’interfaccia utente, è possibile aggiungere il codice utilizzando VI e strut-
ture che controllino gli oggetti del pannello frontale. Lo schema a blocchi
contiene questo codice.

LabVIEW può essere utilizzato per comunicare con un hardware come quello
per l’acquisizione dei dati e la visione, con i dispositivi di controllo del
movimento e con strumenti GPIB, PXI, VXI, RS-232 e RS-485.

Creazione di uno strumento virtuale
Negli esercizi che seguono si creerà un VI che genera un segnale e lo
visualizza in un grafico. Una volta completati gli esercizi, il pannello fron-
tale del VI sarà simile a quello mostrato nella Figura 1-1.

Tempo approssimativo di completamento: 40 minuti.
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Capitolo 1      Introduzione agli strumenti virtuali di LabVIEW

Apertura di un nuovo VI da un modello
LabVIEW fornisce alcuni modelli contenenti informazioni dai quali è pos-
sibile partire per costruire il proprio VI. Questi modelli aiutano a iniziare a
lavorare con il programma. Completando i passi che seguono è possibile
creare un VI che genera un segnale e lo visualizza sul pannello frontale.

1. Avviare LabVIEW.

2. Nella finestra di dialogo LabVIEW, mostrata nella Figura 1-2, fare
clic sul pulsante New per visualizzare la finestra di dialogo New.

Figura 1-1 Il pannello frontale per il VI Acquiring a Signal.

Figura 1-2 La finestra di dialogo LabVIEW.
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3. Selezionare VI from Template»Tutorial (Getting Started)»Generate
and Display dall’elenco a discesa Create new. Questo VI modello
genera e visualizza un segnale.

Nella sezione Front panel preview appare un’anteprima del VI mo-
dello. La Figura 1-3 mostra la finestra di dialogo New e il VI modello
Generate and Display.

4. Fare clic sul pulsante OK per aprire il modello. È anche possibile fare
doppio clic sul nome del VI modello nell’elenco a discesa Create new.

Figura 1-3 La finestra di dialogo New.
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5. Esaminare il pannello frontale del VI.

L’interfaccia utente, o pannello frontale, appare con uno sfondo grigio,
e include controlli e indicatori. La barra del titolo del pannello frontale
indica che questa finestra è il pannello frontale per il VI Generate and
Display.

Nota Se il pannello frontale non è visibile, è possibile visualizzarlo selezionando
Window»Show Front Panel.

6. Esaminare lo schema a blocchi del VI.

Lo schema a blocchi appare con uno sfondo bianco e include le struttu-
re e i VI che controllano gli oggetti del pannello frontale. La barra del
titolo dello schema a blocchi indica che questa finestra è lo schema a
blocchi del VI Generate and Display.

Nota Se lo schema a blocchi non è visibile, è possibile visualizzarlo selezionando
Window»Show Block Diagram.

7. Nella barra degli strumenti del pannello frontale, fare clic sul pulsante
Run, mostrato a sinistra.

Nel grafico appare una sinusoide.

8. Interrompere il VI facendo clic sul pulsante STOP, mostrato a sinistra,
sul pannello frontale.

Aggiunta di un controllo al pannello frontale
I controlli sul pannello frontale simulano i dispositivi di input di uno stru-
mento fisico e forniscono i dati allo schema a blocchi del VI. Molti stru-
menti fisici hanno alcune manopole che possono essere girate per modifi-
care un valore di input. Completando i passi che seguono è possibile ag-
giungere un controllo a manopola al pannello frontale.

Suggerimento In tutti gli esercizi è possibile annullare le modifiche recenti selezionando
Edit»Undo o premendo la combinazione <Ctrl-Z>.

1. Se la palette Controls, mostrata nella Figura 1-4, non è visibile sul
pannello frontale, selezionare Window»Show Controls Palette per
visualizzarla.

Capitolo 1      Introduzione agli strumenti virtuali di LabVIEW



2. Spostare il cursore sulle icone nella palette Controls fino a trovare la
palette Numeric Controls.

Durante questa operazione viene visualizzato il nome della palette se-
condaria nello spazio grigio sopra a tutte le icone della palette. Quando
il cursore è fermo sull’icona di una palette qualsiasi, appaiono il nome
completo della palette secondaria, del controllo o dell’indicatore.

3. Fare clic sull’icona Num Ctrls per accedere alla palette Numeric
Controls.

4. Selezionare la manopola nella palette Numeric Controls e collocarla
sul pannello frontale a sinistra del grafico con la sinusoide.

Questa manopola verrà utilizzata in un esercizio successivo per con-
trollare l’ampiezza di un segnale.

5. Selezionare File»Save As e salvare questo VI con il nome Acquiring
a Signal.vi in un punto facilmente accessibile.

Modifica del tipo di segnale
Lo schema a blocchi contiene un’icona blu chiamata Simulate Signal.
Questa icona rappresenta il VI Express Simulate Signal. Di default, questo
VI simula una sinusoide. Completando i passi che seguono è possibile
modificare questo segnale in un’onda a dente di sega.

1. Visualizzare lo schema a blocchi selezionando Window»Show Block
Diagram o facendo clic su di esso.

Il VI Express Simulate Signal è mostrato a sinistra. Un VI Express è un
componente dello schema a blocchi che può essere configurato per ese-
guire operazioni di misurazione comuni. Il VI Express Simulate Signal
simula un segnale basato sulla configurazione specificata.

2. Fare clic con il pulsante destro del mouse sul VI Express Simulate Signal
e selezionare Properties dal menu di scelta rapida per visualizzare la
finestra di dialogo Configure Simulate Signal.

Figura 1-4 La palette Controls.
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3. Selezionare Sawtooth dall’elenco a discesa Signal type.

La forma dell’onda nel grafico nella sezione Result Preview diventa a
dente di sega. La finestra di dialogo Configure Simulate Signal do-
vrebbe apparire simile a quelle mostrata nella Figura 1-5.

4. Fare clic sul pulsante OK per applicare la configurazione corrente e
chiudere la finestra di dialogo Configure Simulate Signal.

5. Spostare il cursore sulle frecce rivolte verso il basso in fondo al VI
Express Simulate Signal.

6. Quando appare una freccia doppia, come mostratato a sinistra, fare clic
e trascinare il bordo del VI fino a che non apparirà l’input Amplitude.

Il VI Express Simulate Signal è stato espanso per visualizzare un nuo-
vo input. Poiché l’input Amplitude appare nello schema a blocchi, è
possibile configurare l’ampiezza dell’onda a dente di sega al suo interno.

Nella Figura 1-5 Amplitude è un’opzione della finestra di dialogo
Configure Simulate Signal. Quando input come Amplitude appaiono
sia nello schema a blocchi sia nella finestra di dialogo di configurazio-
ne, è possibile configurare gli input in entrambi i punti.

Figura 1-5 La finestra di dialogo Configure Simulate Signal.
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Collegamento degli oggetti nello schema a blocchi
Per utilizzare il controllo a manopola per modificare l’ampiezza del segna-
le è necessario connettere i due oggetti nello schema a blocchi. Completan-
do i passi che seguono è possibile collegare la manopola all’input Amplitude
nel VI Express Simulate Signal.

1. Spostare il cursore sul terminale Knob, mostrato a sinistra, fino a che
non appare lo strumento Positioning.

Il cursore si trasforma in una freccia, ossia nello strumento Positioning.
Lo strumento Positioning può essere utilizzato per selezionare, posi-
zionare e ridimensionare gli oggetti.

2. Fare clic sul terminale Knob per selezionarlo, quindi trascinare il ter-
minale a sinistra del VI Express Simulate Signal. Assicurarsi che il
terminale Knob rientri nel loop, mostrato a sinistra.

I terminali sono rappresentazioni dei controlli e degli indicatori del
pannello frontale. Sono le porte di entrata e di uscita che permettono lo
scambio di informazioni tra il pannello frontale e lo schema a blocchi.

3. Deselezionare il terminale Knob facendo clic su uno spazio vuoto nel-
lo schema a blocchi.

4. Spostare il cursore sulla freccia del terminale Knob, mostrato a sinistra.

Il cursore si trasforma in una spoletta di filo, ossia nello strumento
Wiring, mostrato a sinistra. Lo strumento può essere utilizzato per col-
legare tra loro gli oggetti nello schema a blocchi.

Nota Il cursore non si modifica in un altro strumento fino a che un oggetto rimane selezionato.

5. Quando appare lo strumento Wiring, fare clic sulla freccia e poi
sull’input Amplitude del VI Express Simulate Signal, mostrato a sini-
stra, per collegare tra loro i due oggetti.

Apparirà un filo, che connetterà i due oggetti. I dati fluiscono lungo
questo filo dal terminale al VI Express.

6. Selezionare File»Save per salvare questo VI.
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Esecuzione del VI
L’avvio di un VI comporta l’esecuzione della soluzione progettata. Com-
pletando i passi che seguono è possibile eseguire il VI Acquiring a Signal.

1. Visualizzare il pannello frontale selezionando Window»Show Front
Panel o facendo clic su di esso.

Suggerimento Premere la combinazione <Ctrl-E> per passare dal pannello frontale allo
schema a blocchi e viceversa.

2. Fare clic sul pulsante Run.

3. Spostare il cursore sul controllo a manopola.

Il cursore si trasforma in una mano, ossia nello strumento Operating,
mostrato a sinistra. Utilizzare lo strumento Operating per modificare il
valore di un controllo o per selezionare il testo in un controllo.

4. Utilizzando lo strumento Operating, girare la manopola per regolare
l’ampiezza dell’onda a dente di sega.

L’ampiezza dell’onda a dente di sega cambia con il movimento della
manopola. Inoltre l’asse y del grafico si auto-ridimensiona in base alle
modifiche dell’ampiezza.

Per indicare che il VI è in esecuzione, il pulsante Run si trasforma in
una freccia scura, mostrata a sinistra. Mentre un VI è in esecuzione,
non è possibile modificare il pannello frontale o lo schema a blocchi.

5. Fare clic sul pulsante STOP, mostrato a sinistra, per interrompere il VI.

Nota Sebbene il pulsante Abort Execution  assomigli a un pulsante di interruzione, in
realtà non chiude il VI in modo appropriato. National Instruments consiglia di interrompere i
VI in esecuzione utilizzando il pulsante STOP sul pannello frontale. Il pulsante Abort
Execution può essere utilizzato solo quando alcuni errori impediscono di terminare l’appli-
cazione utilizzando il pulsante STOP.
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Modifica del segnale
Completando i passi che seguono è possibile aggiungere la scalatura al
segnale e visualizzare i risultati nel grafico sul pannello frontale.

1. Nello schema a blocchi, fare doppio clic con lo strumento Positioning
che connette il VI Express Simulate Signal al terminale Graph
Waveform, mostrato a sinistra.

2. Premere <Canc> per eliminare il filo.

3. Se la palette Functions, mostrata nella Figura 1-6, non è visibile, sele-
zionare Window»Show Functions Palette per visualizzarla.

4. Selezionare il VI Express Scaling and Mapping, mostrato a sinistra,
nella palette Arithmetic & Comparison e collocarlo nello schema a
blocchi nel loop tra il VI Express Simulate Signal e il terminale Graph
Waveform. Se non c’è spazio tra questi due elementi, spostare il ter-
minale Graph Waveform a destra.

Quando si colloca il VI Express nello schema a blocchi, appare auto-
maticamente la finestra di dialogo Configure Scaling and Mapping.

Figure 1-6 La palette Functions.

© National Instruments Corporation 1-9 Guida all’uso di LabVIEW

Capitolo 1      Introduzione agli strumenti virtuali di LabVIEW



Guida all’uso di LabVIEW 1-10 ni.com

5. Definire il valore del fattore di scala immettendo 10 nella casella di
testo Slope (m).

La finestra di dialogo Configure Scaling and Mapping dovrebbe ap-
parire simile a quella mostrata nella Figura 1-7.

6. Fare clic sul pulsante OK per applicare la configurazione corrente e
chiudere la finestra di dialogo Configure Scaling and Mapping.

7. Spostare il cursore sulla freccia dell’output Sawtooth del VI Express
Simulate Signal.

8. Quando appare lo strumento Wiring, fare clic sulla freccia e poi sulla
freccia sull’input Signals del VI Express Scaling and Mapping, mo-
strato a sinistra, per connettere i due oggetti.

Figura 1-7 La finestra di dialogo Configure Scaling and Mapping.
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9. Utilizzando lo strumento Wiring, collegare l’output Scaled Signals del
VI Express Scaling and Mapping al terminale Graph Waveform.

Si osservino i fili che connettono il VI Express e i terminali. Le frecce
sui VI Express e sui terminali indicano la direzione del flusso dei dati
lungo i fili. Lo schema a blocchi dovrebbe apparire simile a quello
mostrato nella Figura 1-8.

10. Selezionare File»Save per salvare questo VI.

Visualizzazione di due segnali nel grafico
Per confrontare sullo stesso grafico il segnale generato dal VI Express Si-
mulate Signal e quello generato dal VI Express Scaling and Mapping, si
utilizza la funzione Merge Signals. Completando i passi che seguono è pos-
sibile visualizzare due segnali nello stesso grafico.

1. Spostare il cursore sulla freccia dell’output Sawtooth del VI Express
Simulate Signal.

Figura 1-8 Lo schema a blocchi per il VI Acquiring a Signal.
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2. Utilizzando lo strumento Wiring, collegare l’output Sawtooth al ter-
minale Graph Waveform.

La funzione Merge Signals, mostrata a sinistra, appare nel punto in cui
i due fili si connettono. Questa funzione prende i due segnali separati e
li combina in modo che vengano visualizzati entrambi nello stesso gra-
fico. Lo schema a blocchi dovrebbe apparire simile a quello mostrato
nella Figura 1-9.

Figura 1-9 Lo schema a blocchi che mostra la funzione Merge Signals.

3. Selezionare File»Save per salvare questo VI. Il VI può essere salvato
anche premendo la combinazione <Ctrl-S>.

4. Tornare al pannello frontale, eseguire il VI e girare il controllo a
manopola.

Il grafico riprodurrà l’onda a dente di sega e il segnale scalato. Inoltre il
valore massimo sull’asse y diventa automaticamente 10 volte il valore
della manopola. Questa scalatura avviene perché l’inclinazione è stata
impostata a 10 nel VI Express Scaling and Mapping.

5. Fare clic sul pulsante STOP.

Personalizzazione della manopola
Il controllo a manopola modifica l’ampiezza dell’onda a dente di sega; la
denominazione Amplitude descrive quindi correttamente la sua funzione.
Completando i passi che seguono è possibile personalizzare l’aspetto di un
controllo sul pannello frontale.

1. Fare clic con il pulsante destro del mouse sulla manopola e selezionare
Properties dal menu di scelta rapida per visualizzare la finestra di dia-
logo Knob Properties.
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2. Nella sezione Label della scheda Appearance, eliminare l’etichetta
Knob e immettere Amplitude nella casella di testo.

La finestra di dialogo Knob Properties dovrebbe apparire simile a
quella mostrata nella Figura 1-10.

Figura 1-10 La finestra di dialogo Knob Properties.

3. Fare clic sulla scheda Scale; nella sezione Scale Style collocare un
segno di spunta nella casella di controllo Ramp Visible.

La manopola sul pannello frontale viene aggiornata immediatamente
per riflettere le modifiche.

4. Fare clic sul pulsante OK per applicare la configurazione corrente e
chiudere la finestra di dialogo Knob Properties.

5. Salvare questo VI.

Suggerimento Quando si costruiscono i propri VI, è possibile sperimentare le diverse pro-
prietà e configurazioni ed è possibile aggiungere ed eliminare gli oggetti. Si ricordi che è
possibile annullare le modifiche recenti selezionando Edit»Undo o premendo la combina-
zione <Ctrl-Z>.

6. Utilizzando la finestra di dialogo Knob Properties, è possibile speri-
mentare altre proprietà della manopola. Per esempio, si può provare a
modificare i colori del Marker Text Color facendo clic sul quadratino
colorato nella scheda Scale.
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7. Fare clic sul pulsante Cancel per evitare di applicare le modifiche ap-
portate durante le prove e gli esperimenti. Se si desidera mantenere le
modifiche, fare clic sul pulsante OK.

Personalizzazione del grafico dell’onda
L’indicatore del grafico dell’onda visualizza due segnali. Per indicare qua-
le dei due segnali è quello scalato e quale quello simulato, è possibile
personalizzare il grafico. Completando i seguenti passi è possibile
personalizzare l’aspetto di un indicatore sul pannello frontale.

1. Posizionare il cursore in cima alla legenda del grafico dell’onda.

Si noti che, nonostante il grafico contenga due diagrammi, la legenda
ne visualizza solo uno.

2. Quando appare una freccia doppia (Figura 1-1), fare clic e trascinare il
bordo della legenda del diagramma fino a che non appare il nome del
secondo diagramma.

Figura 1-11 Espandere la legenda dell’indicatore.

3. Fare clic con il pulsante destro del mouse sul grafico dell’onda e sele-
zionare Properties dal menu di scelta rapida per visualizzare la fine-
stra di dialogo Graph Properties.

4. Nella scheda Plots, selezionare Sawtooth dall’elenco a discesa. Fare
clic sul quadratino colorato Line Color per visualizzare il selettore dei
colori. Selezionare un nuovo colore per la linea.

5. Selezionare Sawtooth (Scaled) dall’elenco a discesa.

6. Collocare un segno di spunta nella casella di controllo Don’t use
waveform names for plot names.
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7. Nella casella di testo Name, eliminare l’etichetta corrente e modificare
il nome di questo indicatore in Scaled Sawtooth.

8. Fare clic sul pulsante OK per applicare la configurazione corrente e
chiudere la finestra di dialogo Graph Properties.

Il colore del diagramma sul pannello frontale viene modificato.

9. Utilizzando la finestra di dialogo Graph Properties, è possibile speri-
mentare altre proprietà del grafico. Per esempio, è possibile provare a
disabilitare la funzione di scalatura automatica presente nella scheda
Scales.

10. Fare clic sul pulsante Cancel per evitare di applicare le modifiche ap-
portate durante le prove e gli esperimenti. Se si desidera mantenere le
modifiche, fare clic sul pulsante OK.

11. Salvare e chiudere questo VI.

© National Instruments Corporation 1-15 Guida all’uso di LabVIEW

Capitolo 1      Introduzione agli strumenti virtuali di LabVIEW



Guida all’uso di LabVIEW 1-16 ni.com

Riepilogo
Gli argomenti elencati di seguito sono un riepilogo dei concetti principali
illustrati in questo capitolo.

Finestra di dialogo New e modelli di VI
La finestra di dialogo New contiene numerosi modelli di VI di LabVIEW,
inclusi quelli utilizzati in questo manuale. I modelli di VI aiutano a costrui-
re VI per misurazioni e altre operazioni comuni. Includono le funzioni dei
VI Express e gli oggetti del pannello frontale che possono essere necessari
per iniziare a progettare applicazioni per misurazioni comuni.

Per accedere alla finestra di dialogo New è possibile utilizzare i metodi
elencati di seguito.

• Fare clic sul pulsante New nella finestra di dialogo LabVIEW.

• Fare clic sulla freccia del pulsante New nella finestra di dialogo
LabVIEW e selezionare New dall’elenco a discesa New.

• Selezionare File»New dal pannello frontale o dalla barra dei menu del-
lo schema a blocchi.

Panello frontale
Il pannello frontale è l’interfaccia utente di un VI. Viene costruito utiliz-
zando controlli e indicatori, che sono rispettivamente i terminali interattivi
di input (entrata) e output (uscita) del VI. I controlli e gli indicatori si
trovano nella palette Controls.

I controlli sono manopole, pulsanti da premere, selettori e altri dispositivi
di input. I controlli simulano i dispositivi di input di uno strumento fisico e
forniscono i dati allo schema a blocchi del VI.

Gli indicatori sono grafici, LED e altri display. Gli indicatori simulano i
dispositivi di output di uno strumento fisico e visualizzano i dati acquisiti o
generati dallo schema a blocchi.
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Finestre di dialogo delle proprietà
Le finestre di dialogo delle proprietà o i menu di scelta rapida permettono
di configurare l’aspetto o il comportamento dei controlli e degli indicatori
sul pannello frontale. Per accedere alla finestra di dialogo delle proprietà di
un oggetto (controllo o indicatore), si faccia clic con il pulsante destro del
mouse su di esso sul pannello frontale e si selezioni Properties. Non è
possibile accedere alle finestre di dialogo delle proprietà di un controllo o
di un indicatore quando il VI è in esecuzione.

Schema a blocchi
Lo schema a blocchi contiene il codice sorgente grafico grazie al quale il
VI può essere eseguito. Gli oggetti del pannello frontale appaiono come
terminali sotto forma di icona nello schema a blocchi. I fili connettono i
terminali dei controlli e degli indicatori ai VI Express. I dati fluiscono dai
controlli ai VI Express, da VI Express a VI Express e dai VI Express agli
indicatori attraverso i fili.

VI Express
I VI Express nella palette Functions possono essere utilizzati per operazio-
ni di misurazione comuni. Quando si colloca un VI Express nello schema a
blocchi, appare di default la finestra di dialogo che permette di configurarlo;
questo è il punto dove è possibile impostare le opzioni per specificare il
comportamento dei VI Express.

I VI Express appaiono nello schema a blocchi come nodi espandibili con
icone circondate da un campo blu. È possibile ridimensionarli per
visualizzarne gli input e gli output. Gli input accettano i dati, gli output li
restituiscono. Gli input e gli output per un VI Express dipendono da come
questo viene configurato.
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2
Analisi e salvataggio di un segnale

LabVIEW include un set di VI Express che aiutano ad analizzare i segnali.
Questo capitolo illustra come utilizzare LabVIEW per eseguire un’analisi
di base di un segnale e come salvare i dati analizzati su un file.

Creazione di un VI da un modello
Negli esercizi che seguono si creerà un VI che genera un segnale, ne estrae
il valore DC, indica se il segnale supera un determinato limite e registra i
dati. Una volta completati gli esercizi, il pannello frontale del VI sarà simi-
le a quello mostrato nella Figura 2-1.

Tempo approssimativo di completamento: 40 minuti.

Figura 2-1 Il pannello frontale per il VI.
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Capitolo 2      Analisi e salvataggio di un segnale

Apertura di un nuovo Vi da un modello
Per creare questo VI, si può partire dalla finestra di dialogo New. Comple-
tando i passi che seguono è possibile selezionare un nuovo VI modello che
genera, analizza e visualizza un segnale.

1. Nella finestra di dialogo LabVIEW, fare clic sul pulsante New per
visualizzare la finestra di dialogo New.

Nota È possibile accedere alla finestra di dialogo New anche facendo clic sulla freccia del
pulsante New e selezionando New dall’elenco a discesa New o selezionando File»New sul
pannello frontale o nello schema a blocchi.

2. Selezionare il modello VI from Template»Tutorial (Getting
Started)»Generate, Analyze, and Display dall’elenco Create new.

Il VI modello simula un segnale e lo analizza in base al suo valore
RMS (Root Mean Square).

3. Fare clic sul pulsante OK per aprire un modello. È anche possibile fare
doppio clic sul nome del VI modello nell’elenco Create new.

4. Visualizzare lo schema a blocchi premendo la combinazione <Ctrl-E>.

5. Se la finestra Context Help, mostrata nella Figura 2-2, non è visibile,
selezionare Help»Show Context Help dalla barra dei menu dello sche-
ma a blocchi per visualizzarla.

Nota Per visualizzare la finestra Context Help è anche possibile premere la combinazione
<Ctrl-H>.

6. Posizionare il cursore sul VI Express Amplitude and Level Measu-
rements, mostrato a sinistra.

Quando si sposta il cursore sul VI Express, la finestra Context Help
visualizza le informazioni sul VI Express, comprese quelle sulla sua
configurazione.

Figura 2-2 La finestra Context Help.
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Tenere la finestra Context Help aperta, e osservare il tipo di informa-
zioni utili che fornisce man mano che si procede al completamento
dell’esercizio.

Modifica dello schema a blocchi
Di default, il VI Express Simulate Signal simula una sinusoide. È possibile
personalizzare il segnale simulato modificando le opzioni nella finestra di
dialogo Configure Simulate Signal. Completando i passi che seguono è
possibile modificare il segnale simulato da una sinusoide in un segnale DC
con un disturbo uniforme.

1. Fare clic con il pulsante destro del mouse sul VI Express Simulate Signal
e selezionare Properties dal menu di scelta rapida per visualizzare la
finestra di dialogo Configure Simulate Signal.

2. Selezionare DC dall’elenco a discesa Signal type.

3. Collocare un segno di spunta nella casella di controllo Add noise e
aggiungere un disturbo al segnale DC.

4. Digitare 0.1 nella casella di testo Noise amplitude.

La sezione Result Preview visualizzerà un segnale casuale. La finestra
di dialogo Configure Simulate Signal dovrebbe apparire come mo-
strato nella Figura 2-3.

Figura 2-3 La finestra di dialogo Configure Simulate Signal.
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5. Fare clic sul pulsante OK per salvare la configurazione corrente e chiu-
dere la finestra di dialogo Configure Simulate Signal.

6. Visualizzare il pannello frontale premendo la combinazione <Ctrl-E>.

7. Eseguire il VI.

Il segnale apparirà nel grafico e il valore RMS del segnale apparirà
nell’indicatore digitale.

8. Fare clic sul pulsante STOP.

9. Selezionare File»Save As e salvare questo VI come Analysis.vi
in un punto facilmente accessibile.

Modifica del pannello frontale
Se si decide di non utilizzare uno degli indicatori forniti dal modello, è
possibile eliminarlo. Completando i passi che seguono è possibile rimuo-
vere l’indicatore RMS dal pannello frontale.

1. Spostare il cursore sull’indicatore RMS fino a che non appare lo stru-
mento Positioning.

2. Fare clic sull’indicatore RMS, mostrato a sinistra, per selezionarlo e
premere <Canc>.

3. Visualizzare lo schema a blocchi.

Lo schema a blocchi contiene ora un filo tratteggiato con una X rossa,
come mostrato a sinistra. Si tratta di un filo spezzato. Anche il pulsante
Run, mostrato a sinistra, appare spezzato, a indicare che il VI non può
essere eseguito.

4. Fare clic sul pulsante Run spezzato per visualizzare la finestra Error
list.

La finestra Error list elenca tutti gli errori nel VI e fornisce dettagli su
ciascuno di essi.

5. Nel riquadro di riepilogo Errors and Warnings, fare doppio clic sul-
l’errore Wire: has loose ends per evidenziare il filo spezzato.

LabVIEW visualizza automaticamente il problema che ha causato l’errore.

6. Premere <Canc> per eliminare il filo spezzato.

Suggerimento Premere la combinazione <Ctrl-B> per eliminare tutti i fili spezzati nello
schema a blocchi.
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7. Selezionare Windows»Show Error List per visualizzare la finestra
Error list. Come si può notare, ora il riquadro di riepilogo Errors and
Warnings non elenca più alcun errore.

Nota Per visualizzare la finestra Error list è anche possibile premere la combinazione
<Ctrl-L>.

8. Fare clic sul pulsante Close per chiudere questa finestra.

Il pulsante Run non appare più spezzato.

Analisi dell’ampiezza di un segnale
Il VI Express Amplitude and Level Measurements include alcune opzioni
che permettono di analizzare le caratteristiche del voltaggio di un segnale.
Completando i passi che seguono è possibile riconfigurare il VI Express
per misurare i valori di picco dell’ampiezza del segnale.

1. Fare clic con il pulsante destro del mouse sul VI Express Amplitude
and Level Measurements e selezionare Properties dal menu di scelta
rapida per visualizzare la finestra di dialogo Configure Amplitude and
Level Measurements.

Suggerimento Per aprire la finestra di dialogo Configure Amplitude and Level
Measurements è anche possibile fare doppio clic sul VI Express.

2. Rimuovere il segno di spunta dalla casella di controllo RMS nella se-
zione Amplitude Measurements.

3. Fare clic sul pulsante Help, mostrato a sinistra, nell’angolo inferiore
destro della finestra di dialogo Configure Amplitude and Level
Measurements per visualizzare l’argomento del LabVIEW Help rela-
tivo a questo VI Express.

L’argomento della guida descrive il VI Express, i suoi input e output e
le opzioni di configurazione. Ogni VI Express ha un argomento corri-
spondente nella guida, a cui si accede facendo clic sul pulsante Help.

4. Nell’argomento Amplitude and Level Measurements, trovare il para-
metro di output la cui descrizione indica che esso misura la differenza
tra il picco massimo e il picco minimo del segnale.

5. Ridurre a icona il LabVIEW Help per tornare alla finestra di dialogo
Configure Amplitude and Level Measurements.
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6. Selezionare l’input o l’output che si è deciso di utilizzare.

L’opzione selezionata, Peak to Peak, apparirà nella sezione Results
con il valore corrispondente della misurazione.

7. Fare clic sul pulsante OK per chiudere la finestra di dialogo Configure
Amplitude and Level Measurements e tornare allo schema a blocchi.

L’output RMS nel VI Express Amplitude and Level Measurements è
stato modificato in modo da riflettere il nuovo parametro Peak to Peak,
mostrato a sinistra.

Aggiunta di una spia luminosa
Se si desidera avere un segnale visivo che indichi quando un valore supera
un determinato limite, è possibile utilizzare una spia luminosa. Completan-
do i passi che seguono è possibile aggiungere una spia luminosa al VI.

1. Dalla palette Controls, selezionare l’indicatore del LED rotondo nella
palette LEDs, mostrata nella Figura 2-4, e collocarlo sul pannello fron-
tale a sinistra del grafico dell’onda.

Figura 2-4 La palette LEDs.

2. Fare clic con il pulsante destro del mouse sul LED e selezionare
Properties dal menu di scelta rapida per visualizzare la finestra di dia-
logo Button Properties.

3. Modificare l’etichetta del LED in Warning.

4. Fare clic sul pulsante OK per salvare la configurazione corrente e chiu-
dere la finestra di dialogo Button Properties.

Questo LED verrà utilizzato in un esercizio successivo per segnalare
quando un valore supera il suo limite.

5. Selezionare File»Save As e salvare questo VI come Warning
Light.vi in un punto facilmente accessibile.
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Impostazione del livello limite di accensione della spia
Per specificare il valore in base al quale la spia luminosa deve accendersi, è
possibile utilizzare il VI Express Comparison. Completando i passi che
seguono è possibile confrontare il valore da picco a picco con un limite
impostato.

1. Nello schema a blocchi, selezionare il VI Express Comparison nella
palette Arithmetic & Comparison»Express Comparison e collocar-
lo a destra del VI Express Amplitude and Level Measurements.

2. Nella finestra di dialogo Configure Comparison, selezionare l’opzio-
ne > Greater than dalla sezione Compare Condition.

3. Nella sezione Comparison Inputs, selezionare Use constant value e
digitare 0.195 nella casella di testo Constant value.

4. Chiudere la pagina di configurazione e tornare allo schema a blocchi.

Il nome del VI Express Comparison rifletterà l’operazione sul VI
Express, come mostrato a sinistra. Greater Than indica che il VI
Express effettua un confronto del tipo “maggiore di”.

5. Connettere l’output Peak to Peak del VI Express Amplitude and Level
Measurements all’input Operand 1 del VI Express Comparison.

6. Spostare il cursore sul filo che connette l’output Peak to Peak all’input
Operand 1.

7. Quando appare lo strumento Positioning, fare clic con il pulsante de-
stro del mouse sul filo che collega l’output Peak to Peak all’input
Operand 1 e selezionare Create» Numeric Indicator dal menu di
scelta rapida.

Si noti che nello schema a blocchi appare il terminale Peak to Peak,
mostrato a sinistra. Se il terminale Peak to Peak si trova sovrapposto
ai fili dei VI Express, spostare i VI Express e il terminale Peak to Peak
per creare spazio. Per esempio, spostare il terminale Peak to Peak nel-
lo spazio vuoto sopra i VI Express.

Capitolo 2      Analisi e salvataggio di un segnale



Guida all’uso di LabVIEW 2-8 ni.com

Avvertire l’utente
Dopo aver specificato i valori in corrispondenza dei quali si desidera che la
spia luminosa si accenda, è necessario collegare la spia al VI Express
Comparison. Completando i passi che seguono è possibile fornire un se-
gnale visivo all’utente quando il valore da picco a picco del segnale supera
il limite specificato.

1. Nello schema a blocchi, spostare il terminale Warning a destra del VI
Express Comparison. Accertarsi che il terminale si trovi nel loop, come
mostrato nella Figura 2-5.

2. Connettere l’output Result del VI Express Comparison al terminale
Warning.

Lo schema a blocchi dovrebbe apparire simile a quello mostrato nella
Figura 2-5.

Figura 2-5 Lo schema a blocchi per il VI Warning Light.

3. Visualizzare il pannello frontale.

Nel pannello frontale appare un indicatore numerico Peak to Peak che
visualizza il valore da picco a picco del segnale.

4. Eseguire il VI.

Quando il valore da picco a picco supera 0.195, l’indicatore Warning
si accende.

5. Fare clic sul pulsante STOP per interrompere il VI.

6. Selezionare File»Save per salvare questo VI.
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Configurazione del VI per il salvataggio dei dati su un file
Per memorizzare le informazioni sui dati generati dai propri VI, è possibile
utilizzare il VI Express Write LabVIEW Measurement File. Completando i
passi che seguono è possibile creare un VI che salva i valori da picco a
picco e altre informazioni in un file di dati di LabVIEW.

1. Selezionare il VI Express Write LabVIEW Measurement File nella
palette Output e collocarlo nello schema a blocchi sotto e a destra del
VI Express Amplitude and Level Measurements.

La casella di testo File name indica che il file di output è test.lvm e
visualizza il percorso completo per il file test.lvm. Un file .lvm è un
file di dati di misurazione di LabVIEW che LabVIEW colloca nella
directory predefinita LabVIEW Data. LabVIEW installa la directory
LabVIEW Data nella directory di file predefinita del sistema operativo.

Se si desidera visualizzare il file, seguire il percorso visualizzato nella
casella di testo File name per accedere al file test.lvm.

2. Nella finestra di dialogo Configure Write LabVIEW Measurement
File, selezionare l’opzione Append to file nella sezione If a file already
exists.

Se si seleziona Append to file, LabVIEW scrive tutti i dati nel file
test.lvm senza cancellare i dati esistenti nel file qualora esista già
un file con quel nome.

3. Selezionare l’opzione One header only nella sezione Segment
Headers.

4. Immettere Sample of peak to peak values nella casella di
testo File Description.

5. Chiudere la finestra di dialogo Configure Write LabVIEW
Measurement File e tornare allo schema a blocchi.

Salvataggio dei dati su un file
Quando si esegue questo VI, LabVIEW salva i dati nel file test.lvm.
Completando i passi che seguono è possibile generare il file test.lvm.

1. Connettere l’output Peak to Peak del VI Express Amplitude and Level
Measurements all’input Signals del VI Express Write LabVIEW
Measurement File.

2. Selezionare File»Save As e salvare questo VI come Save Data.vi
in un punto facilmente accessibile.
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3. Visualizzare il pannello frontale ed eseguire il VI.

4. Fare clic sul pulsante STOP sul pannello frontale.

5. Per visualizzare i dati salvati, aprire il file LabVIEW Data\test.lvm
con un’applicazione di foglio elettronico o un elaboratore di testi.

6. Dopo averlo analizzato, chiudere il file e tornare al VI Save Data.

Aggiunta di un pulsante per la memorizzazione
Se si desidera memorizzare solo alcuni dati, è possibile configurare il VI
Express Write LabVIEW Measurement File per salvare i valori da picco a
picco solo quando un utente preme un pulsante. Completando i passi che
seguono è possibile aggiungere un pulsante al VI e configurarne il compor-
tamento quando un utente fa clic su di esso.

1. Sul pannello frontale, selezionare il pulsante con la leva nella palette
Buttons & Switches e collocarlo a destra del grafico dell’onda.

2. Utilizzando la finestra di dialogo Button Properties, modificare l’eti-
chetta del pulsante in Write to File.

3. Sulla scheda Operation, selezionare Latched When Pressed dall’elen-
co Button Behavior.

La scheda Operation viene utilizzata per specificare il comportamen-
to di un pulsante quando un utente fa clic su di esso. Per vedere come il
pulsante reagisce a un clic, fare clic sul pulsante nella sezione Preview
Selected Behavior.

4. Chiudere la finestra di dialogo Button Properties.

5. Salvare questo VI.

Salvataggio dei dati su un file dietro input dell’utente
Completando i passi che seguono è possibile creare un VI che registra i dati
su un file quando l’utente fa clic su un pulsante sul pannello frontale.

1. Nello schema a blocchi, fare doppio clic sul VI Express Write LabVIEW
Measurement File per accedere alla finestra di dialogo Configure Write
LabVIEW Measurement File.

2. Nella casella di testo File name, modificare il nome del file test.lvm
in Selected Samples.lvm per salvare i dati in un file diverso.

3. Chiudere la finestra di dialogo Configure Write LabVIEW
Measurement File.
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4. Fare clic con il pulsante destro del mouse sull’input Signal del VI
Express Write LabVIEW Measurement File. Selezionare Insert Input/
Output dal menu di scelta rapida per inserire l’input Comment.

5. Fare clic con il pulsante destro del mouse sull’input Comment del VI
Express Write LabVIEW Measurement File. Selezionare Input/
Output»Enable dal menu di scelta rapida per inserire l’input Enable.

Nell’esercizio precedente si è visto come aggiungere input e output
espandendo il VI Express utilizzando le frecce rivolte verso il basso.
Questo metodo è diverso dalla visualizzazione e selezione degli input e
output di un VI Express. Gli input e output di un VI Express appaiono
in un ordine predeterminato ogni volta che se ne aggiungono di nuovi.
Per selezionare un input specifico potrebbe essere necessario aggiun-
gere prima un input e poi modificarlo in quello specifico che si deside-
ra utilizzare.

6. Spostare il terminale Write to File a sinistra del VI Express Write
LabVIEW Measurement File.

7. Connettere il terminale Write to File all’input Enable del VI Express
Write LabVIEW Measurement File.

Lo schema a blocchi dovrebbe apparire simile a quello mostrato nella
Figura 2-6.

Figura 2-6 Lo schema a blocchi per il VI Save Data.
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8. Visualizzare il pannello frontale ed eseguire il VI. Fare clic più volte
sul pulsante Write to File.

9. Fare clic sul pulsante STOP sul pannello frontale.

10. Per visualizzare i dati salvati, aprire il file Selected Samples.lvm
con un’applicazione di foglio elettronico o un elaboratore di testi.

Il file Selected Samples.lvm differisce dal file test.lvm.
test.lvm ha registrato tutti i dati generati dal VI Save Data, mentre
Selected Samples.lvm ha registrato i dati solo quando è stato
premuto il pulsante Write to File.

11. Salvare e chiudere questo VI.
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Riepilogo
Gli argomenti elencati di seguito sono un riepilogo dei concetti principali
illustrati in questo capitolo.

Risorse di aiuto di LabVIEW
LabVIEW include una documentazione estesa per i nuovi utenti inesperti.
Le risorse di aiuto comprendono manuali, la finestra Context Help, il
LabVIEW Help, alcuni esempi e alcune note applicative.

Nota Tutti i manuali di LabVIEW e le note applicative si trovano anche su PDF. Per poter
visualizzare i PDF è necessario aver installato Adobe Acrobat Reader con Search and
Accessibility 5.0.5 o versioni successive. Si faccia riferimento al sito Web Adobe Systems
Incorporated all’indirizzo www.adobe.com per scaricare Acrobat Reader.

La finestra Context Help visualizza alcune informazioni di base sugli og-
getti di LabVIEW ogni volta che si sposta il cursore su uno di essi. Per
accedere alla finestra Context Help, si selezioni Help»Show Context Help.
È anche possibile premere la combinazione <Ctrl-H>.

Il LabVIEW Help contiene informazioni sui VI Express di LabVIEW, i con-
trolli, gli indicatori, le palette, i menu, gli strumenti, i VI e le funzioni.
Questo file di aiuto include anche istruzioni passo passo per l’utilizzo delle
funzioni di LabVIEW. Per accedere alle informazioni di aiuto dei VI Express,
si faccia clic sul pulsante Help, mostrato a sinistra, nella finestra di dialogo
di configurazione mentre si configura un VI Express. Per accedere al
LabVIEW Help è anche possibile selezionare Help»VI, Function, & How-
To Help o premere la combinazione <Ctrl-?>.

Controlli e indicatori
I controlli e gli indicatori sul pannello frontale possono essere configurati
per eseguire operazioni che impostino un determinato comportamento del
proprio VI. Quello che segue è un riepilogo dei diversi modi presentati in
questo capitolo per utilizzare i controlli e gli indicatori.

• È possibile creare VI che eseguono automaticamente una determinata
operazione quando si verificano alcune condizioni; un esempio è la
visualizzazione di una spia luminosa quando un valore supera un limi-
te specificato.

• È possibile creare VI che permettono agli utenti di controllare quando
un VI Express viene eseguito utilizzando i pulsanti e l’input Enable. È

Capitolo 2      Analisi e salvataggio di un segnale



Guida all’uso di LabVIEW 2-14 ni.com

possibile configurare i pulsanti perché operino in uno dei sei modi pre-
visti utilizzando la scheda Operations della finestra di dialogo Button
Properties.

Salvataggio dei dati
Il VI Express Write LabVIEW Measurement File salva i dati generati e
analizzati da un VI in un file di dati. Il file di dati di misurazione di LabVIEW
(.lvm) è un file di testo delimitato da tabulazioni che può essere aperto
con un’applicazione di foglio elettronico o un elaboratore di testi. Il file
.lvm include inoltre alcune intestazioni che contengono informazioni sui
dati, come la data e l’ora in cui questi sono stati generati.

Per memorizzare i file di dati generati da LabVIEW, il programma installa
la directory LabVIEW Data nella directory di file predefinita del sistema
operativo per favorire l’organizzazione e il recupero dei file generati dal
programma.

Nota Il LabVIEW Help contiene le informazioni sul salvataggio dei dati e il loro recupero
da un file .lvm.

Errori e collegamenti interrotti
Il pulsante Run appare spezzato quando il VI che si sta creando o modifi-
cando contiene degli errori. Se il pulsante Run rimane spezzato anche dopo
che si è terminato di connettere lo schema a blocchi, il VI viene interrotto e
non può essere eseguito.

Per scoprire perché un VI è stato interrotto, si faccia clic sul pulsante Run
spezzato o si selezioni Window»Show Error List. È possibile utilizzare la
finestra Error list per trovare gli errori nello schema a blocchi. Facendo
doppio clic sull’errore nel riquadro di riepilogo Errors and Warnings si
può evidenziare il problema che causa l’errore.

Un filo spezzato appare come una linea nera tratteggiata con una X rossa al
centro. I fili si spezzano per le ragioni più varie, come l’eliminazione di
oggetti collegati. Se lo schema a blocchi contiene fili spezzati, il VI non
può essere eseguito.

Se si sposta lo strumento Wiring su un filo spezzato, si vede apparire una
casella di aiuto che spiega perché il filo è spezzato. Questa informazione
appare anche nella finestra Context Help. Si faccia clic con il pulsante
destro del mouse sul filo e si selezioni List Errors dal menu di scelta rapi-
da per visualizzare la finestra Error list. Si faccia clic sul pulsante Help
per avere ulteriori informazioni sul perché un filo si è spezzato.
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3
Ampliamento delle funzioni di un VI

Quando si decide di creare un VI, è possibile utilizzare uno dei numerosi
modelli forniti da LabVIEW come punto di partenza. Può tuttavia essere
necessario creare un VI per il quale non è disponibile alcun modello. Que-
sto capitolo illustra come creare e personalizzare un VI senza utilizzare un
modello.

Creazione di un VI da un modello vuoto
Negli esercizi che seguono verrà aperto un VI vuoto e verranno aggiunti
alcuni VI Express e alcune strutture allo schema a blocchi per costruire un
nuovo VI. In particolare, verrà creato un VI che genera un segnale, riduce il
numero di campioni nel segnale e visualizza i dati risultanti sul pannello
frontale. Una volta completati gli esercizi, il pannello frontale del VI sarà
simile a quello mostrato nella Figura 3-1.

Tempo approssimativo di completamento: 30 minuti.

Figura 3-1 Il pannello frontale per il VI Reduce Samples.
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Apertura di un VI vuoto
Se non è disponibile alcun modello per l’operazione che si intende far svol-
gere al VI, è possibile iniziare con un VI vuoto e aggiungere poi i VI Express
necessari a eseguire l’operazione desiderata. Completando i passi che se-
guono è possibile aprire un VI vuoto.

1. Nella finestra di dialogo LabVIEW, fare clic sul pulsante a freccia del
pulsante New e selezionare Blank VI dal menu di scelta rapida o pre-
mere la combinazione <Ctrl-N> per aprire un VI vuoto.

Appariranno un pannello frontale vuoto e uno schema a blocchi.

Nota Un VI vuoto può essere aperto anche selezionando Blank VI dall’elenco Create new
nella finestra di dialogo New o selezionando File»New VI dalla barra dei menu del pannello
frontale o della schema a blocchi.

2. Se la palette Functions non è visibile, fare clic con il pulsante destro
del mouse su uno spazio vuoto nello schema a blocchi per richiamare
la versione temporanea della palette. Fare clic sulla puntina da dise-
gno, mostrata a sinistra, nell’angolo superiore della palette per posizio-
nare la palette sullo schermo.

Nota Per visualizzare le palette Functions o Controls è possibile fare clic con il pulsante
destro del mouse su uno spazio vuoto nello schema a blocchi o nel pannello frontale.

Aggiunta di un VI Express che simula un segnale
Completando i passi che seguono è possibile trovare il VI Express che si
desidera utilizzare e aggiungerlo allo schema a blocchi.

1. Se la finestra Context Help non è visibile, premere la combinazione
<Ctrl-H> per aprirla. È anche possibile fare clic sul pulsante Show
Context Help Window, mostrato a sinistra.

2. Selezionare la palette Input nella palette Functions e spostare il cursore
sui VI Express nella palette Input.

Si noti che la finestra Context Help visualizza le informazioni sulle
funzioni di ciascun VI Express.

3. In base alle informazioni fornite dalla finestra Context Help, trovare il
VI Express che può produrre un segnale sinusoidale.

4. Selezionare il VI Express e collocarlo nello schema a blocchi. Apparirà
la finestra di dialogo Configure Simulate Signal.
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5. Posizionare il cursore sulle varie opzioni nella finestra di dialogo
Configure Simulate Signal, come Frequency (Hz), Amplitude e
Samples per second (Hz) e leggere le informazioni che appaiono nel-
la finestra Context Help.

6. Configurare il VI Express Simulate Signal in modo che generi una
sinusoide con una frequenza di 10.7 e un’ampiezza di 2.

7. Il segnale visualizzato nella finestra Result Preview verrà modificato
in modo da riflettere la sinusoide configurata.

8. Chiudere la finestra di dialogo Configure Simulate Signal.

9. Posizionare il cursore sul VI Express Simulate Signal e leggere le in-
formazioni che appaiono nella finestra Context Help.

La finestra Context Help visualizzerà la configurazione del VI Express
Simulate Signal.

10. Salvare il VI come Reduce Samples.vi in un punto facilmente
accessibile.

Modifica del segnale
Completando i passi che seguono è possibile utilizzare il LabVIEW Help
per cercare il VI Express che riduce il numero di campioni in un segnale.

1. Selezionare Help»VI, Function, & How-To Help per aprire il
LabVIEW Help.

2. Fare clic sulla scheda Search e digitare sample compression
nella casella di testo Type in the word(s) to search for.

La parola immessa in questa casella di testo riflette l’operazione che si
desidera eseguire attraverso il VI Express, in questo caso comprimere
(compress) o ridurre il numero dei campioni nel segnale.

3. Selezionare l’argomento Sample Compression Express VI per
visualizzare la descrizione del VI Express Sample Compression.

4. Dopo aver letto la descrizione del VI Express, fare clic sul pulsante
Place on the block diagram per selezionare il VI Express.

5. Spostare il cursore nello schema a blocchi.

LabVIEW associa il VI Express Sample Compression al cursore.
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6. Collocare il VI Express Sample Compression nello schema a blocchi a
destra del VI Express Simulate Signal.

7. Configurare il VI Express Sample Compression in modo da ridurre il
segnale di un fattore pari a 25 utilizzando la media dei valori.

8. Chiudere la finestra di dialogo Configure Sample Compression.

9. Utilizzando lo strumento Wiring, connettere l’output Sine nel VI Express
Simulate Signal all’input Signals nel VI Express Sample Compression.

Personalizzazione del pannello frontale
Negli esercizi precedenti si è visto come aggiungere controlli e indicatori al
pannello frontale utilizzando la palette Controls. La stessa operazione può
essere effettuata dallo schema a blocchi. Completando i passi che seguono
è possibile creare controlli e indicatori.

1. Fare clic con il pulsante destro del mouse sull’output Mean del VI
Express Sample Compression e selezionare Create»Numeric Indicator
dal menu di scelta rapida per creare un indicatore numerico.

2. Fare clic con il pulsante destro del mouse sull’output Mean del VI
Express Sample Compression e selezionare Insert Input/Output dal
menu di scelta rapida per inserire l’input Enable.

3. Fare clic con il pulsante destro del mouse sull’input Enable e selezio-
nare Create»Control dal menu di scelta rapida per creare un interrut-
tore (switch) Enable.

4. Fare clic con il pulsante destro del mouse sul filo che connette l’output
Sine nel VI Express Simulate Signal all’input Signals nel VI Express
Signal Compression e selezionare Create»Graph Indicator dal menu
di scelta rapida.

Si noti che è possibile creare controlli e indicatori dallo schema a bloc-
chi; in questo caso LabVIEW crea automaticamente alcuni terminali
che vengono etichettati e formattati correttamente.

5. Utilizzando lo strumento Wiring, connettere l’output Mean nel VI
Express Sample Compression al terminale Sine.

Appare la funzione Merge Signals.

6. Disporre gli oggetti nello schema a blocchi in modo che appaiano simi-
li a quelli mostrati nella Figura 3-2.
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Suggerimento Per fare in modo che LabVIEW disponga automaticamente i fili, è possibile
fare clic con il pulsante destro del mouse su un filo qualsiasi e selezionare Clean Up Wire dal
menu di scelta rapida.

7. Visualizzare il pannello frontale.

I controlli e gli indicatori aggiunti automaticamente appariranno sul
pannello frontale con alcune etichette che ne descrivono la funzione.

8. Salvare questo VI.

Configurazione del VI per l’esecuzione continua
fino all’interruzione da parte dell’utente

Allo stato corrente, il VI viene eseguito una volta, genera un segnale e poi
viene interrotto. Per eseguirlo fino a che non viene soddisfatta una determi-
nata condizione, è possibile aggiungere un loop While allo schema a bloc-
chi. Completando i passi che seguono è possibile aggiungere un loop While.

1. Visualizzare il pannello frontale ed eseguire il VI.

Il VI viene eseguito una volta e poi viene interrotto. Si noti che non è
disponibile un pulsante STOP.

2. Visualizzare lo schema a blocchi e selezionare il loop While nella pa-
lette Execution Control.

3. Collocare il cursore nell’angolo superiore sinistro dello schema a bloc-
chi e posizionare l’angolo superiore sinistro del loop While in questo
punto.

Figura 3-2 Lo schema a blocchi per il VI Reduce Samples.
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4. Fare clic e trascinare il cursore diagonalmente per racchiudere tutti i VI
Express e i fili, come mostrato nella Figura 3-3.

Figura 3-3 I VI Express sono racchiusi dal loop While.

Il loop While, mostrato a sinistra, comprende un pulsante STOP ed è
configurato in modo tale da interrompersi quando l’utente fa clic su
questo pulsante.

5. Visualizzare il pannello frontale ed eseguire il VI.

Il VI verrà eseguito finché non si fa clic sul pulsante STOP. Un loop
While esegue le funzioni all’interno del loop fino a che l’utente non
preme il pulsante STOP.

Controllo della velocità di esecuzione
Per tracciare in modo più lento i punti sul grafico dell’onda, è possibile
aggiungere un tempo di ritardo allo schema a blocchi. Completando i se-
guenti passi è possibile controllare la velocità di esecuzione del VI.

1. Nello schema a blocchi, selezionare il VI Express Time Delay nella
palette Execution Control e collocarlo nel loop.

2. Digitare 250i nella casella di testo Time delay (seconds).

Questo tempo di ritardo specifica la velocità di esecuzione del VI. Con
un ritardo di 0.250 secondi, il loop viene ripetuto ogni quarto di secondo.

3. Chiudere la finestra di dialogo Configure Time Delay.

4. Salvare questo VI.
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5. Visualizzare il pannello frontale ed eseguire il VI.

6. Fare clic sull’interruttore Enable e osservare le modifiche nel grafico.

Se l’interruttore Enable è acceso, il grafico visualizza il segnale ridot-
to; se invece è spento, il grafico non visualizza il segnale ridotto.

7. Fare clic sul pulsante STOP per interrompere il VI.

Uso di una tabella per la visualizzazione dei dati
Completando i seguenti passi è possibile visualizzare una raccolta di valori
medi in una tabella nel pannello frontale.

1. Sul pannello frontale, selezionare l’indicatore Express Table nella pa-
lette Text Indicators e collocarlo a destra del grafico dell’onda.

2. Visualizzare lo schema a blocchi.

Il terminale Table appare automaticamente connesso al VI Express Build
Table.

3. Se il VI Express Build Table e il terminale Table non sono già selezio-
nati, fare clic su un’area aperta nello schema a blocchi a sinistra del VI
Express Build Table e del terminale Table. Trascinare il cursore diago-
nalmente fino a che il rettangolo di selezione non racchiude il VI Express
Build Table e il terminale Table, mostrato a sinistra.

Una linea tratteggiata mobile, chiamata rettangolo di selezione,
evidenzierà il VI Express Build Table, il terminale Table e il filo che li
unisce.

4. Trascinare gli oggetti nel loop While a destra del terminale Mean.

Il loop While si ridimensiona automaticamente per includere il VI
Express Build Table e il terminale Table.

5. Utilizzando lo strumento Wiring, connettere il terminale Mean del VI
Express Sample Compression all’input Signals del VI Express Build
Table.
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Lo schema a blocchi dovrebbe essere simile a quello mostrato nella
Figura 3-4.

Figura 3-4 Lo schema a blocchi per il VI Reduce Samples.

6. Visualizzare il pannello frontale ed eseguire il VI.

7. Fare clic sull’interruttore Enable.

La tabella visualizza i valori medi ogni 25 campioni della sinusoide. Se
l’interruttore Enable è spento, la tabella non registra i valori medi.

8. Interrompere il VI.

9. È possibile fare qualche esperimento con le proprietà delle tabelle uti-
lizzando la finestra di dialogo Table Properties. Per esempio, è possi-
bile provare a modificare il numero delle colonne a una sola.

10. Salvare e chiudere questo VI.
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Riepilogo
Gli argomenti elencati di seguito sono un riepilogo dei concetti principali
illustrati in questo capitolo.

Risorse di aiuto di LabVIEW
La finestra Context Help e il LabVIEW Help possono essere utilizzati per
sapere qualcosa di più sui VI Express. Entrambi forniscono informazioni
che descrivono la funzionalità del VI Express e il modo in cui configurarlo.

Quello che segue è un breve riepilogo dei diversi modi di utilizzare le risor-
se di aiuto illustrati in questo capitolo.

• La finestra Context Help visualizza alcune informazioni di base sugli
oggetti di LabVIEW ogni volta che si sposta il cursore su uno di essi.
Gli oggetti con informazioni di aiuto contestuali includono i VI, le strut-
ture, le palette e i componenti delle finestra di dialogo.

• Quando si colloca un VI Express nello schema a blocchi, la finestra
Context Help visualizza una breve descrizione del VI e le informazio-
ni sulla sua configurazione.

• Il LabVIEW Help permette di trovare e selezionare un VI Express e
altri oggetti dello schema a blocchi. Si faccia clic sul pulsante Place on
the block diagram per selezionare un oggetto dello schema a blocchi
e collocarlo all’interno di questo.

• Per spostarsi in LabVIEW Help, si utilizzino le schede Contents, Index
e Search. La scheda Contents offre una panoramica degli argomenti e
della struttura dell’aiuto. La scheda Index permette di trovare un argo-
mento in base a una parola chiave. Si utilizzi la scheda Search per
eseguire una ricerca in base a una parola o una frase.

Personalizzazione del codice dello schema a blocchi
Esistono numerosi controlli, indicatori, VI Express e strutture che possono
essere utilizzati per personalizzare un VI. È possibile creare controlli e in-
dicatori, controllare l’interruzione dell’esecuzione di un VI e visualizzare
in una tabella i dati generati.

Creazione di controlli e indicatori
Per creare dallo schema a blocchi controlli e indicatori che siano connessi
ai VI, si faccia clic con il pulsante destro del mouse sull’input, l’output o il
filo del VI Express e si selezioni un’opzione dal menu di scelta rapida Create.
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Interruzione dell’esecuzione di un VI
Si utilizzi il loop While per eseguire in continuazione il codice racchiuso al
suo interno. Il loop While interrompe la sua esecuzione quando viene sod-
disfatta una condizione di interruzione. Quando si posiziona o si sposta
vicino al bordo un oggetto in un loop While, il loop si ridimensiona auto-
maticamente per creare spazio per quell’oggetto.

La palette Execution Control include oggetti che permettono di controlla-
re il numero di esecuzioni e la velocità dell’esecuzione di un VI.

Visualizzazione dei dati in una tabella
L’indicatore di tabella visualizza i dati raccolti. Si utilizzi il VI Express
Build Table per costruire una tabella dei dati raccolti.
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4
Acquisizione dei dati e comunicazione
con gli strumenti

Questo capitolo presenta i VI Express utilizzabili per l’acquisizione dei
dati e la comunicazione strumentale su un PC Windows.

Si faccia riferimento al LabVIEW Measurements Manual per informazioni
sull’acquisizione dei dati e la comunicazione strumentale su tutte le piatta-
forme.

Acquisizione di un segnale
Negli esercizi che seguono si utilizzerà il VI Express DAQ Assistant per
creare un task NI-DAQmx. Si faccia riferimento al tutorial Taking an NI-
DAQmx Measurement in LabVIEW per informazioni su metodi supplemen-
tari per creare questo tipo di task. Per avviare il tutorial, si selezioni
Help»Taking an NI-DAQmx Measurement in LabVIEW.

Nota Per gli esercizi che seguono è necessario aver installato NI-DAQmx e un dispositivo
supportato da NI-DAQmx. Il sito Web di National Instruments all’indirizzo ni.com/daq
contiene un elenco di questi dispositivi. Se non si è installato NI-DAQmx o un dispositivo da
esso supportato, si faccia riferimento al LabVIEW Measurements Manual per informazioni
sull’uso di Traditional NI-DAQ per l’acquisizione dei dati.

Una volta completati gli esercizi, si sarà creato un task NI-DAQmx che
effettua letture continue del voltaggio e riporta i dati nel grafico dell’onda.

Tempo approssimativo di completamento: 30 minuti.

© National Instruments Corporation 4-1 Guida all’uso di LabVIEW



Creazione di un task NI-DAQmx
In NI-DAQmx, un task è una raccolta di uno o più canali, temporizzazioni,
attivazioni e altre proprietà che si applicano al task stesso. Concettualmente
rappresenta una misurazione o una generazione che si desidera eseguire.
Per esempio, è possibile creare un task che misura la temperatura da uno o
più canali su un dispositivo DAQ. Completando i passi che seguono è pos-
sibile creare e configurare un’operazione che legge il livello del voltaggio
da un dispositivo DAQ.

1. Aprire un nuovo VI.

2. Selezionare il VI Express DAQ Assistant, mostrato a sinistra, nella
palette Input e collocarlo nella schema a blocchi. Il DAQ Assistant
viene avviato e appare una finestra di dialogo Create New.

3. Fare clic sul pulsante Analog Input per visualizzare le opzioni Analog
Input.

4. Selezionare Voltage per creare un nuovo task di input analogico per il
voltaggio.

La finestra di dialogo visualizza un elenco di canali su ciascun disposi-
tivo DAQ installato. Il numero dei canali elencati dipende da quello
presente sul dispositivo DAQ.

5. Nel riquadro di riepilogo My Physical Channels, selezionare il canale
fisico a cui è connesso il segnale, come ai0, e fare clic sul pulsante
Finish. Il DAQ Assistant apre una nuova finestra, mostrata nella Figu-
ra 4-1, che visualizza le opzioni per la configurazione del canale sele-
zionato per completare il task.
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6. Nella sezione Input Range della scheda Settings, immettere 10 per il
valore Max e -10 per il valore Min.

7. Nella scheda Task Timing, selezionare l’opzione Acquire N Samples.

8. Immettere il valore 1000 nella casella di testo Samples To Read.

Figura 4-1 Configurare un task utilizzando il DAQ Assistant.

© National Instruments Corporation 4-3 Guida all’uso di LabVIEW



Prova del task
È possibile provare il task per vedere se il canale è stato configurato corret-
tamente. Completando i passi che seguono è possibile confermare
l’acquisizione dei dati.

1. Fare clic sul pulsante Test, mostrato a sinistra. Apparirà una finestra di
dialogo Analog Input Test Panel.

2. Fare clic sul pulsante Start una o due volte per confermare l’acquisizione
dei dati; fare quindi clic sul pulsante OK per tornare al DAQ Assistant.

3. Fare clic sul pulsante OK per tornare allo schema a blocchi.

4. Salvare questo VI come Read Voltage.vi in un punto facilmente
accessibile.

Creazione di un grafico dei dati acquisiti con un dispositivo DAQ
Utilizzando il task creato nell’esercizio precedente, è possibile creare un
grafico dei dati acquisiti con un dispositivo DAQ. Completando i passi che
seguono è possibile trasferire i dati dal canale nel grafico dell’onda e modi-
ficare il nome del segnale.

1. Nello schema a blocchi, fare clic con il pulsante destro del mouse
sull’output data e selezionare Create»Graph Indicator.

2. Visualizzare il pannello frontale.

3. Eseguire il VI tre o quattro volte e osservare il grafico dell’onda.

Si noti che la parola Voltage appare nella legenda del grafico dell’onda.

4. Visualizzare lo schema a blocchi.

5. Fare clic con il pulsante destro del mouse sul VI Express DAQ Assistant
e selezionare Properties per rinominare il canale.

6. Fare clic con il pulsante destro del mouse su Voltage nel riquadro di
riepilogo Channel List e selezionare Rename per visualizzare la fine-
stra di dialogo Rename a channel or channels.

Suggerimento Per accedere alla finestra di dialogo Rename a channel or channels è an-
che possibile selezionare il nome del canale e premere <F2>.

7. Nella casella di testo New Name, immettere First Voltage
Reading e fare clic sul pulsante OK.

8. Fare clic sul pulsante OK per applicare questa configurazione e tornare
allo schema a blocchi.

9. Visualizzare il pannello frontale ed eseguire il VI.
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Si noti che la parola First Voltage Reading appare nella legenda del
grafico dell’onda.

10. Salvare questo VI.

Modifica di un task NI-DAQmx
È possibile aggiungere un canale al task in modo da poter confrontare due
letture di voltaggio separate. È inoltre possibile personalizzare il task di
modo che acquisisca le letture del voltaggio senza interruzioni. Comple-
tando i passi che seguono è possibile aggiungere un nuovo canale al task e
acquisire i dati continuamente.

1. Visualizzare lo schema a blocchi e fare doppio clic sul VI Express DAQ
Assistant per aggiungere un nuovo canale.

2. Fare clic sul pulsante Add Step, mostrato a sinistra, per aprire la fine-
stra di dialogo Add Channels To Task.

3. Selezionare uno qualsiasi dei canali non utilizzati nel riquadro di riepi-
logo My Physical Channels.

4. Fare clic sul pulsante OK per tornare al DAQ Assistant.

5. Rinominare il canale Second Voltage Reading.

6. Sulla scheda Task Timing, selezionare l’opzione Acquire Con-
tinuously.

Quando si impostano le opzioni di temporizzazione e attivazione nel
DAQ Assistant, queste vengono applicate a tutti i canali contenuti nel-
l’elenco Channel List.

7. Fare clic sul pulsante OK per applicare questa configurazione e tornare
allo schema a blocchi.

8. Collocare un loop While attorno al VI Express Assistant e all’indicato-
re del grafico connesso all’output data. Lo schema a blocchi dovrebbe
apparire simile a quello mostrato nella Figura 4-2.

Figura 4-2 Lo schema a blocchi per il VI Read Voltage.
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Confronto visivo di due letture di voltaggio
Poiché sul grafico sono visualizzate due letture di voltaggio, è possibile
personalizzare i due diagrammi per distinguerli. Completando i passi che
seguono è possibile personalizzare il colore degli diagrammi sul grafico
dell’onda.

1. Sul pannello frontale, espandere la legenda in modo che includa i due
diagrammi.

2. Eseguire il VI.

I due diagrammi appaiono nel grafico e la legenda viene aggiornata
automaticamente per includere entrambi i diagrammi.

3. Fare clic con il pulsante destro del mouse su First Voltage Reading e
selezionare Color dal menu di scelta rapida. Utilizzando il selettore dei
colori, selezionare un colore, come il giallo, così che il diagramma sia
facile da leggere. Modificare quindi il colore del diagramma Second
Voltage Reading.

4. Salvare questo VI.

Comunicazione con uno strumento
I driver degli strumenti semplificano il controllo strumentale e riducono il
tempo di sviluppo del programma di prova eliminando la necessità di ap-
prendere il protocollo di programmazione per ogni strumento. È quindi
preferibile utilizzare i driver degli strumenti ogniqualvolta è possibile.
National Instruments fornisce driver per un’ampia gamma di strumenti. Si
visiti il sito Web NI Instrument Driver Network all’indirizzo ni.com/
idnet per trovare un driver adatto al proprio strumento.

Se non ci sono driver adatti disponibili, si può utilizzare il VI Express
Instrument I/O per comunicare con lo strumento. Una volta completati gli
esercizi che seguono, sarà possibile comunicare con uno strumento.

Selezione di uno strumento
Prima di comunicare con uno strumento, è necessario selezionare lo stru-
mento con il quale si desidera farlo. Completando i passi che seguono è
possibile selezionare uno strumento utilizzando il VI Express Instrument
I/O Assistant.
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1. Assicurarsi di aver attivato lo strumento che si desidera utilizzare, o
non sarà possibile manipolarlo con il VI Express Instrument I/O
Assistant.

2. Selezionare il VI Express Instrument I/O Assistant nella palette Input
e collocarlo nello schema a blocchi.

3. Fare clic sul pulsante Show Help, mostrato a sinistra, nell’angolo su-
periore destro della finestra di dialogo Instrument I/O Assistant.

Il pulsante Show Help visualizza un aiuto a destra della finestra di
dialogo. La casella di aiuto in alto contiene informazioni sull’uso del
VI Express Instrument I/O Assistant. La casella di aiuto in basso forni-
sce informazioni sensibili al contesto sui vari controlli e indicatori nel-
la finestra di dialogo.

4. Seguire le procedure nella casella di aiuto in alto per selezionare lo
strumento con il quale si intende comunicare.

5. Se necessario, configurare le proprietà dello strumento.

6. Fare clic sul pulsante Hide Help, mostrato a sinistra, nell’angolo supe-
riore destro della finestra di dialogo Instrument I/O Assistant per ri-
durre a icona la casella di aiuto.

Acquisizione e analisi di informazioni per uno strumento
Dopo aver selezionato uno strumento, è possibile inviare a esso i comandi
per recuperare i dati. In questo esercizio si illustrerà come utilizzare il VI
Express Instrument I/O Assistant per acquisire e analizzare le informazioni
di identificazione di uno strumento. Completando i passi che seguono è
possibile comunicare con lo strumento.

1. Fare clic sul pulsante Add Step e selezionare Query and Parse.

2. Immettere *IDN? nella casella di testo Enter a command.

*IDN? è una query riconosciuta dalla maggior parte degli strumenti.
La risposta è una stringa numerica di identificazione che descrive lo
strumento. Se lo strumento non accetta questo comando, si faccia rife-
rimento al suo manuale d’uso per avere un elenco dei comandi accettati.

3. Fare clic sul pulsante Run Sequence.

Il VI Express Instrument I/O Assistant invia il comando allo strumento
e questo restituisce le proprie informazioni identificative.
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4. Analizzare il nome dello strumento come una stringa ASCII. È anche
possibile utilizzare il VI Express Instrument I/O Assistant per analizza-
re i numeri ASCII e i dati binari.

5. Fare clic sul pulsante Parsing help, mostrato a sinistra, nella finestra
di dialogo Instrument I/O Assistant per avere ulteriori informazioni
sull’analisi dei dati.

6. Assegnare un nome al token nella casella di testo Token name.

Un token è una selezione di dati analizzati.

7. Fare clic sul pulsante OK per tornare allo schema a blocchi.

Si noti che il nome immesso nella casella di testo Token name è l’output
del VI Express Instrument I/O Assistant, mostrato a sinistra.
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Riepilogo
Gli argomenti elencati di seguito sono un riepilogo dei concetti principali
illustrati in questo capitolo.

VI Express DAQ Assistant
Il VI Express DAQ Assistant può essere utilizzato per configurare grafica-
mente i canali o le operazioni di misurazione più comuni. Utilizzandolo, è
possibile costruire interattivamente un canale o un task di misurazione.

Si collochi il VI Express DAQ Assistant nello schema a blocchi per
configurare canali e task da utilizzare con NI-DAQmx per l’acquisizione
dei dati.

NI-DAQmx è un’interfaccia di programmazione per la comunicazione con
i dispositivi di acquisizione dei dati. È possibile utilizzare il VI Express
DAQ Assistant per controllare i dispositivi supportati in NI-DAQmx.

Si faccia riferimento al tutorial Taking an NI-DAQmx Measurement in
LabVIEW per avere informazioni sul DAQ Assistant. Per avviare il tutorial,
si selezioni Help»Taking an NI-DAQmx Measurement in LabVIEW.

Il sito Web di National Instruments all’indirizzo ni.com/daq contiene le
informazioni sui dispositivi supportati in NI-DAQmx. Se il proprio dispo-
sitivo non è supportato in NI-DAQmx, si faccia riferimento al LabVIEW
Measurements Manual per le informazioni sull’uso di NI-DAQ per
l’acquisizione dei dati.

Task
In NI-DAQmx, un task è una raccolta di uno o più canali, temporizzazioni,
attivazioni e altre proprietà che si applicano al task stesso. Concettualmente,
un task rappresenta una misurazione o una generazione che si intende ese-
guire. Per esempio, è possibile configurare una raccolta di canali per opera-
zioni di input analogici. Una volta creato un task, non è necessario
configurare i canali singolarmente per eseguire operazioni di input analogi-
ci ma è sufficiente accedere al singolo task. È inoltre possibile aggiungere
o rimuovere i canali da esso.

Per ulteriori informazioni sui canali e i task, si consulti il Capitolo 5 del
LabVIEW Measurements Manual.
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VI Express Instrument I/O Assistant
Un driver di strumento è un insieme di routine software che controlla uno
strumento programmabile. Ogni routine corrisponde a un’operazione
programmatica, come la configurazione, la lettura, la visualizzazione e l’at-
tivazione dello strumento. National Instruments offre migliaia di driver degli
strumenti online. Si visiti il sito Web NI Instrument Driver Network all’in-
dirizzo ni.com/idnet per trovare un driver per il proprio strumento.

Se non è disponibile il driver necessario, è possibile utilizzare il VI Express
Instrument I/O Assistant per comunicare con lo strumento. L’Instrument
I/O Assistant consente di comunicare con uno strumento seriale, Ethernet o
GPIB e di analizzare graficamente la risposta. Si avvii l’Instrument I/O
Assistant collocando il VI Express Instrument I/O Assistant nello schema a
blocchi o facendo clic sull’icona relativa nello schema a blocchi.

Per ulteriori informazioni sulla comunicazione con un dispositivo esterno,
si consulti l’aiuto specifico dell’Instrument I/O Assistant.
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5
Altre funzioni di LabVIEW

I capitoli precedenti di questo manuale hanno presentato la maggior parte
delle funzioni di LabVIEW necessarie a creare applicazioni di misurazione
comuni. Man mano che si familiarizza con l’ambiente di LabVIEW, può
rendersi necessario migliorare i propri VI e ottenere un controllo più preci-
so sui processi da questi eseguiti. Questo capitolo illustra alcuni dei concet-
ti che dovrebbero essere noti quando si iniziano a utilizzare altre funzioni
di LabVIEW. Per ulteriori informazioni in merito, si consulti il Capitolo 5
del LabVIEW User Manual.

NI Example Finder (localizzatore di esempi)
La finestra di dialogo New contiene numerosi modelli di VI di LabVIEW
che possono essere utilizzati per iniziare a creare i propri VI. Questi VI
modello sono tuttavia solo un sottoinsieme delle centinaia di VI d’esempio
inclusi in LabVIEW. È possibile modificare qualsiasi VI d’esempio per
adattarlo a un’applicazione oppure copiare e incollare alcuni elementi in un
VI creato autonomamente.

Oltre agli esempi di VI forniti con LabVIEW, è possibile accedere a centi-
naia di altri VI d’esempio sul sito Web NI Developer Zone all’indirizzo
ni.com/zone. Per ricercare tra tutti gli esempi che utilizzano i VI di
LabVIEW, ci si può servire di NI Example Finder, un comodo accesso ver-
so tutti gli esempi installati e quelli che si trovano in NI Developer Zone.

Per avviare NI Example Finder, si selezioni Help»Find Examples dalla
barra dei menu del pannello frontale o dello schema a blocchi. In alternati-
va, si può avviarlo facendo clic sulla freccia del pulsante Open nella fine-
stra di dialogo di LabVIEW e selezionando Examples dal menu che appare.
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Tutti i controlli e gli indicatori
I controlli e gli indicatori che si trovano nelle palette secondarie del livello
superiore della palette Controls sono un sottoinsieme dei controlli e degli
indicatori predefiniti disponibili in LabVIEW. La palette secondaria All
Controls contiene tutti i controlli e gli indicatori che possono essere utiliz-
zati per creare il pannello frontale. Invece di fornire una palette secondaria
specifica, questa palette secondaria ordina i controlli e gli indicatori in base
alla loro funzionalità.

Per esempio, il livello superiore della palette Controls ha una palette se-
condaria Numeric Controls e una Numeric Indicators. Poiché i controlli
e gli indicatori della palette secondaria All Controls sono tutti oggetti nu-
merici, si trovano nella palette secondaria Numeric.

Completando i passi che seguono è possibile modificare la visualizzazione
delle palette e visualizzare le palette secondarie dalla palette secondaria All
Controls al livello superiore della palette Controls.

1. Fare clic sul pulsante Options, mostrato a sinistra, nella barra degli
strumenti della palette Controls per visualizzare la pagina Controls/
Functions Palettes della finestra di dialogo Options.

2. Selezionare Advanced dall’elenco a discesa Palette View.

3. Fare clic sul pulsante OK per applicare le modifiche.

Per ulteriori informazioni sull’uso del set completo di controlli e indi-
catori predefiniti disponibili in LabVIEW, si consulti il Capitolo 4 del
LabVIEW User Manual.

Tutti i VI e le funzioni
I VI Express e le strutture collocati nelle palette secondarie al livello supe-
riore della palette Functions sono un sottoinsieme dei VI, delle funzioni e
delle strutture predefiniti disponibili in LabVIEW. La palette secondaria
All Functions contiene tutti i VI, le funzioni e le strutture che possono
essere utilizzati per creare lo schema a blocchi.

Le strutture nella palette secondaria All Functions sono simili a quelle pre-
senti nella palette secondaria Execution Control. Per esempio, quando si
seleziona un loop While nella palette secondaria Execution Control e lo si
colloca nello schema a blocchi, appare anche un pulsante di interruzione
che viene connesso al terminale condizionale. Se invece si seleziona un
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loop While nella palette secondaria Structures e lo si colloca nello schema
a blocchi, il pulsante di interruzione non appare.

Completando i passi che seguono è possibile modificare la visualizzazione
delle palette e visualizzare le palette secondarie dalla palette secondaria All
Functions al livello superiore della palette Functions.

Nota Se si modifica la visualizzazione della palette come descritto nel paragrafo “Controlli
e indicatori”, le palette secondarie della palette secondaria All Functions appariranno al li-
vello superiore della palette Functions. Per modificare la visualizzazione della palette non è
necessario completare i passi che seguono.

1. Fare clic sul pulsante Options, mostrato a sinistra, nella barra degli
strumenti della palette Functions per visualizzare la pagina Controls/
Functions Palettes della finestra di dialogo Options.

2 Selezionare Advanced dall’elenco a discesa Palette View.

3. Fare clic sul pulsante OK per applicare le modifiche.

LabVIEW utilizza icone colorate per distinguere tra VI, funzioni e VI
Express. Le icone per i VI hanno uno sfondo bianco, quelle per le funzioni
uno giallo chiaro e quelle per i VI Express appaiono nello schema a blocchi
come nodi di icone espandibili circondati da un campo blu.

A differenza dei VI Express, la maggiore parte delle funzioni e dei VI nello
schema a blocchi appare sotto forma di icone che di default non possono
essere espanse.

VI
Quando si colloca un VI nello schema a blocchi, LabVIEW lo considera
come un VI secondario. Quando si fa doppio clic su un VI secondario,
appaiono un pannello frontale e uno schema a blocchi invece di una fine-
stra di dialogo nella quale configurare le varie opzioni. Il pannello frontale
include controlli e indicatori che possono sembrare familiari. Lo schema a
blocchi include fili, icone del pannello frontale, funzioni, eventuali VI se-
condari e altri oggetti LabVIEW anch’essi familiari.

L’angolo superiore destro del pannello di controllo e dello schema a bloc-
chi visualizza l’icona del VI. Questa icona è uguale a quella che appare
quando si colloca il VI nello schema a blocchi.

È possibile creare un VI da utilizzare come VI secondario. Per ulteriori
informazioni sulla creazione dei VI e sulla loro configurazione come VI
secondari, si consulti il Capitolo 7 del LabVIEW User Manual.
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È inoltre possibile salvare la configurazione di un VI Express come VI
secondario. Per ulteriori informazioni in merito, si consulti il Capitolo 5
del LabVIEW User Manual.

Funzioni
Le funzioni sono gli elementi operativi fondamentali di LabVIEW. Le fun-
zioni non hanno pannelli frontali o schemi a blocchi ma hanno riquadri
connettori. Un doppio clic su una funzione ne comporta la semplice
selezione.

Tipi di dati
Man mano che si costruisce lo schema a blocchi per un VI, si può notare
che i terminali per gli oggetti del pannello frontale appaiono in un colore
diverso. Il colore e il simbolo di ciascun terminale indicano il tipo di dati
del controllo o dell’indicatore. I colori indicano anche i tipi di dati dei fili,
degli input e degli output. Il colore degli input e degli output sui VI Express
indicano quali tipi di dati vengono accettati o restituiti.

I terminali dei controlli hanno un bordo più spesso rispetto a quello dei
terminali degli indicatori. Sui terminali del pannello frontale appaiono inoltre
delle frecce, a indicare se il terminale è un controllo o un indicatore. Se il
terminale è un controllo, la freccia appare a destra; se è un indicatore, appa-
re a sinistra.

I tipi di dati indicano quali oggetti, input e output si possono connettere.
Per esempio, un interruttore ha un bordo verde, a indicare che è possibile
connetterlo a qualsiasi input che ha un’etichetta verde in un VI Express.
Una manopola ha un bordo arancione e può essere connessa a qualsiasi
input che abbia un’etichetta arancione. Non è quindi possibile connettere
una manopola a un input che ha un’etichetta verde. Si noti che i fili sono
dello stesso colore del terminale.

Per ulteriori informazioni sui tipi di dati, si faccia riferimento al Capitolo 5
del LabVIEW User Manual.

Tipo di dati dinamico
Il tipo di dati dinamico memorizza le informazioni generate o acquisite da
un VI Express. I tipi di dati dinamici appaiono come un terminale blu scu-
ro, mostrato a sinistra. La maggior parte dei VI Express accetta e/o restitui-
sce il tipo di dati dinamico. È possibile connettere il tipo di dati dinamico a
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qualsiasi indicatore o input che accetti dati numerici, di forma di onda o
booleani. Si consiglia di connettere il tipo di dati dinamico all’indicatore
che presenta meglio i dati. Gli indicatori includono grafici, diagrammi e
indicatori numerici.

La maggior parte degli altri VI e funzioni di LabVIEW accetta il tipo di dati
dinamico. Per utilizzare un VI o una funzione predefiniti per analizzare o
elaborare le inclusioni di dati dinamici, è necessario convertire il tipo di
dati dinamico.

Conversione dai dati dinamici
Il VI Express Convert from Dynamic Data consente di convertire i tipi di
dati dinamici in tipi di dati numerici, booleani, a forma di onda e di array da
utilizzare con altri VI e funzioni. Quando si colloca questo VI Express nel-
lo schema a blocchi, appare la finestra di dialogo Configure Convert from
Dynamic Data. Questa finestra di dialogo contiene le opzioni che permet-
tono di specificare come si desidera formattare i dati restituiti dal VI Express
Convert from Dynamic Data.

Per esempio, se si è acquisita una sinusoide da un dispositivo di acquisizione
dei dati, si selezioni l’opzione Single waveform nella finestra di dialogo
Configure Convert from Dynamic Data e si connetta l’output Waveform
del VI Express a una funzione o VI che accetti il tipo di dato a forma di
onda. Se si è acquisita una raccolta di temperature da diversi canali utiliz-
zando un dispositivo DAQ, si selezionino le opzioni 1D array of scalars –
most recent values e Floating point numbers (double). Si connetta quin-
di l’output Array del VI Express Convert from Dynamic Data a una fun-
zione o VI che accetti un array numerico come input.

Quando si connette un tipo di dati dinamico a un indicatore di array,
LabVIEW colloca automaticamente il VI Express Convert from Dynamic
Data nello schema a blocchi. Si faccia doppio clic su questo VI Express per
aprire la finestra di dialogo Configure Convert from Dynamic Data, che
controlla come i dati appaiono nell’array.

Conversione in dati dinamici
Il VI Express Convert to Dynamic Data consente di convertire tipi di dati
numerici, booleani, di forma di onda e di array in tipi di dati dinamici da
utilizzare con i VI Express. Quando si colloca il VI Convert to Dynamic
Data nello schema a blocchi, appare la finestra di dialogo Configure
Convert to Dynamic Data. Si utilizzi questa finestra di dialogo per sele-
zionare il tipo di dati da convertire in dati dinamici.
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Per esempio, se si acquisisce una sinusoide utilizzando il VI Analog Input e
si desidera utilizzare il VI Express Signal Analysis per analizzare il segna-
le, si selezioni l’opzione Single waveform nella finestra di dialogo
Configure Convert to Dynamic Data. Si connetta quindi l’output Dynamic
Data Type a un VI Express che accetta il tipo di dati dinamico come input.

Quando utilizzare altre funzioni di LabVIEW
I VI Express, le strutture, i controlli e gli indicatori collocati nelle palette
secondarie al livello superiore delle palette Functions e Controls fornisco-
no la funzionalità necessaria a costruire applicazioni di misurazione comu-
ni. L’elenco che segue descrive le applicazioni che richiedono l’impiego di
VI, funzioni, strutture, controlli e indicatori collocati nelle palette seconda-
rie All Functions e All Controls.

1. Proprietà e metodi per il controllo programmatico dell’ambiente,
dei VI, dei controlli e degli indicatori di LabVIEW—È possibile
controllare programmaticamente il modo in cui un VI si comporta quan-
do viene chiamato o eseguito, per impostare l’aspetto di un controllo o
indicatore o per controllare il comportamento dell’ambiente di
LabVIEW. Per ulteriori informazioni in merito, si consulti il Capitolo
17 del LabVIEW User Manual.

2. Chiamare un codice da linguaggi basati su testo—È possibile utiliz-
zare LabVIEW per comunicare con applicazioni scritte in un linguaggio
di programmazione basato su testo, come C o C++. Per ulteriori infor-
mazioni in merito, si consulti il Capitolo 20 del LabVIEW User Manual.

3. Comunicare con altre applicazioni LabVIEW in rete—È possibile
chiamare un VI che risiede su un altro computer su cui è installato
LabVIEW. Per ulteriori informazioni in merito, si consulti il Capitolo
18 del LabVIEW User Manual.

4. Pubblicare i VI sul Web—Il pannello frontale di qualsiasi VI creato
può essere pubblicato sul Web, dove l’utente può interagire con esso.
Per ulteriori informazioni in merito, si consulti il Capitolo 18 del
LabVIEW User Manual.

5. Salvare i dati in vari formati di file—Oltre al formato di file dei dati
di misurazione di LabVIEW, è possibile creare file che possono essere
utilizzati da altre applicazioni. Per ulteriori informazioni in merito, si
consulti il Capitolo 14 del LabVIEW User Manual.

6. Personalizzare i menu—È possibile configurare quali voci di menu
devono apparire quando un utente esegue un VI. È inoltre possibile
creare menu personalizzati. Per ulteriori informazioni in merito, si con-
sulti il Capitolo 16 del LabVIEW User Manual.
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A
Assistenza tecnica e servizi
per professionisti

Le sezioni riportate di seguito del sito Web ni.com forniscono un’assi-
stenza tecnica e servizi per professionisti.

• Support—Le risorse di assistenza tecnica on-line contengono quanto
segue.

– Self-Help Resources—Per avere risposte e soluzioni immediate,
si visiti l’ampia libreria di risorse di assistenza tecnica in inglese,
giapponese e spagnolo all’indirizzo ni.com/support. Queste
risorse sono disponibili per la maggior parte dei prodotti senza co-
sti per gli utenti registrati e includono driver e aggiornamenti
software, risposte alle FAQ e ai problemi più frequenti, manuali
dei prodotti, procedure guidate per la risoluzione dei problemi,
documentazioni di conformità, codici di esempio, tutorial e note
applicative, driver degli strumenti, forum di discussione, un glos-
sario per la misurazione e così via.

– Assisted Support Options—È possibile contattare gli ingegneri
di NI e altri professionisti della misurazione e dell’automazione
all’indirizzo ni.com/support. Il sistema on-line aiuta l’utente
a definire le proprie domande e a entrare in contatto con gli esperti
per telefono, tramite i forum di discussione o la posta elettronica.

• Training—All’indirizzo ni.com/custed è possibile trovare tutorial
personalizzati, video e CD interattivi. È inoltre possibile iscriversi ai
vari corsi proposti in tutto il mondo.

• System Integration—Se si hanno vincoli di tempo, risorse tecniche
limitate e altri problemi legati ai progetti, è possibile contattare i mem-
bri di NI Alliance Program. Per saperne di più, si contatti la propria
sede NI locale o si visiti il sito ni.com/alliance.



Se nel sito ni.com non si sono trovate le risposte alle proprie domande, si
contatti la propria sede NI locale o la sede centrale della società. I numeri di
telefono nel mondo sono riportati all’inizio di questo manuale. È inoltre
possibile visitare la sezione Worldwide Offices del sito ni.com/
niglobal per accedere ai siti specifici delle varie sedi, che forniscono
informazioni aggiornate sui contatti, numeri di telefono dell’assistenza e
notizie sugli eventi correnti.

Appendice A      Assistenza tecnica e servizi per professionisti
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A
Acquisizione 1. Acquisizione e misurazione di segnali elettrici analogici o digitali da

sensori, trasduttori di acquisizione, sonde o impianti.

2. Generazione di segnali elettrici analogici o digitali.

B
Barra degli strumenti Barra che contiene i pulsanti di comando per eseguire i VI e per effettuare

il debugging.

Barra dei menu Barra orizzontale che elenca i nomi dei menu principali di un’applicazione.
La barra dei menu appare sotto la barra del titolo di una finestra. Ogni
applicazione ha una barra dei menu specifica, sebbene alcuni menu e co-
mandi siano comuni a più applicazioni.

C
Campione Singolo punto di dati di output o input analogici o digitali.

Canale 1. Fisico—Terminale o punto in base al quale si può misurare o generare
un segnale analogico o digitale. Un canale fisico singolo può includere più
di un terminale, come nel caso di un canale di input analogico differenziale
o di una porta digitale di otto linee. Il nome utilizzato per un canale fisico di
contatore è un’eccezione, perché il nome del canale fisico non è il nome del
terminale su cui il contatore misura o genera il segnale digitale.

2. Virtuale—Raccolta di impostazioni di proprietà che possono includere
un nome, un canale fisico, alcune connessioni di terminale di input, il tipo
di misurazione o generazione e le informazioni sulla scala. È possibile de-
finire canali NI-DAQmx virtuali all’esterno di un task (globalmente) o al-
l’interno (localmente). La configurazione di canali virtuali è facoltativa in
Traditional e NI-DAQ e nelle versioni precedenti, ma è parte integrante di
ogni misurazione eseguita in NI-DAQmx. In Traditional NI-DAQ è possi-
bile configurare canali virtuali in MAX. In NI-DAQmx è possibile
configurare i canali virtuali sia in MAX sia in un programma e i canali
possono essere configurati come parte di un task o separatamente.

Glossario

dei dati (DAQ)
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3. Interruttore—Canale interruttore che rappresenta qualsiasi punto di con-
nessione su un interruttore. Può essere costituito da uno o più fili di segnale
(solitamente uno, due o quattro), a seconda della sua topologia. Un canale
virtuale non può essere creato con un canale interruttore. I canali interrutto-
re possono essere utilizzati solo nelle funzioni Swtich di NI-DA Qmx e VI.

Casella di controllo Quadratino in una finestra di dialogo dove è possibile collocare o rimuove-
re segni di spunta. Le caselle di controllo sono solitamente associate a op-
zioni multiple che possono essere impostate. È possibile collocare un se-
gno di spunta in più di una casella di controllo.

Context Help Finestra che visualizza le informazioni di base sugli oggetti di LabVIEW
quando si posiziona il cursore su uno di essi. Gli oggetti con informazioni
di aiuto contestuali includono i VI, le funzioni, le costanti, le strutture, le
palette, le proprietà, i metodi, gli eventi e i componenti delle finestre di
dialogo.

Controlli e indicatori Oggetti del pannello frontale per la manipolazione e la visualizzazione dei
dati booleani (TRUE o FALSE).

Controllo Oggetto del pannello frontale per l’immissione interattiva dei dati in un VI
o l’immissione programmata in un VI secondario, come una manopola, un
pulsante da premere o un selettore.

Controls Palette che contiene controlli del pannello frontale, indicatori e oggetti de-
corativi.

D
DAQ Assistant Interfaccia grafica per la configurazione di task di misurazione, canali e

scale.

DAQ Vedere Acquisizione dei dati (DAQ).

Derivazione di filo Sezione di un filo che contiene tutti i segmenti di file da un giunto all’altro,
da un terminale a un giunto o da un terminale a un terminale se non vi sono
giunti intermedi.

Dispositivo Strumento o controllo a cui si può accedere come singola entità che con-
trolla i punti di I/O del mondo reale. Un dispositivo è spesso connesso a un
computer host attraverso un qualche tipo di rete di comunicazione. Vedere
anche Dispositivo DAQ e Dispositivo di misurazione.

booleani
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Dispositivo DAQ Dispositivo che acquisisce o genera dati e che può contenere più canali e
dispositivi di conversione. I dispositivi DAQ includono i dispositivi di
plug-in, le schede PCMCIA e i dispositivi DAQPad, che connettono all’USB
di un computer o a una porta 1394 (FireWire). I moduli SCXI sono consi-
derati dispositivi DAQ.

Dispositivo Dispositivi DAQ come i dispositivi MIO (Multifunction I/O) E-Series, i
moduli di condizionamento del segnale SCXI e i moduli degli interruttori.

Driver Software specifico per il dispositivo o il tipo di dispositivo che include
l’insieme dei comandi da questo accettati.

Driver dello strumento Insieme di funzioni di alto livello che controllano e comunicano con
l’hardware dello strumento in un sistema.

E
Etichetta Oggetto di testo utilizzato per denominare o descrivere gli oggetti o le re-

gioni sul pannello frontale o nello schema a blocchi.

F
Filo Percorso dei dati tra i nodi.

Finestra del pannello Finestra del VI che contiene il pannello frontale, la barra degli strumenti e
i riquadri delle icone e dei connettori.

Flusso di dati Sistema di programmazione costituito da nodi eseguibili che vengono ese-
guiti solo quando ricevono tutti i dati di input richiesti e che producono
automaticamente un output. LabVIEW è un sistema di flusso di dati.

Forma dell’onda Letture a voltaggio multiplo prese a una frequenza di campionamento spe-
cifica.

Functions Palette che contiene VI, funzioni, strutture di schemi a blocchi e costanti.

Funzione Elemento di esecuzione predefinito, paragonabile a un operatore, una fun-
zione o un’istruzione in un linguaggio di programmazione basato su testo.

di misurazione
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G
Giunto di file Punto in cui si uniscono tre o più segmenti di filo.

Grafico Rappresentazione grafica bidimensionale di una serie di dati di una o più
strutture. Un grafico riceve e struttura i dati come un blocco.

Grafico dell’onda Indicatore che struttura i dati in base a una frequenza specifica.

I
I/O Input/Output. Trasferimento dei dati a o da un sistema di computer che

coinvolge canali di comunicazione, dispositivi di input dell’operatore e/o
interfacce di acquisizione e controllo dei dati.

Icona Rappresentazione grafica di un nodo in uno schema a blocchi.

Indicatore Oggetto del pannello frontale che visualizza l’output, come un grafico o un
LED.

Indicatori e controlli Oggetti del pannello frontale per la manipolazione e la visualizzazione dei
dati numerici.

L
LabVIEW Laboratory Virtual Instrument Engineering Workbench. LabVIEW è un lin-

guaggio di programmazione grafico che utilizza le icone anziché le righe di
testo per creare i programmi.

LED Light-Emitting Diode.

Legenda Parte di un grafico che visualizza i nomi e gli stili degli elementi del grafico.

M
Menu a discesa Menu ai quali si accede da una barra dei menu. La loro natura è solitamente

generica.

Menu di scelta rapida Menu a cui si accede facendo clic con il pulsante destro del mouse su un
oggetto; le voci di menu che appaiono sono specifiche per quell’oggetto.

numerici
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Messaggio di errore Segnalazione di un malfunzionamento software o hardware o di un tentati-
vo di immissione dati non valido.

N
NI-DAQ Software di driver incluso in tutti i dispositivi di misurazione NI. NI-DAQ

è una libreria estesa di VI e funzioni che possono essere chiamate da un
ambiente di sviluppo delle applicazioni (ADE), come LabVIEW, per pro-
grammare tutte le funzioni di un dispositivo di misurazione NI, come la
configurazione, l’acquisizione e la generazione di dati dal dispositivo e
l’invio di dati allo stesso.

NI-DAQmx Il driver NI-DAQ più recente con i nuovi VI, funzioni e strumenti di svilup-
po per il controllo dei dispositivi di misurazione. I vantaggi di NI-DAQmx
rispetto alle versioni precedenti di NI-DAQ includono: il DAQ Assistant
per la configurazione dei canali e dei task di misurazione per il dispositivo
da utilizzare in LabVIEW, LabWindows™CVI™ e Measurement Studio;
prestazioni aumentate per un I/O analogico a punto singolo più veloce; un
API più semplice per la creazione di applicazioni DAQ utilizzando meno
funzioni e VI rispetto alle versioni precedenti di NI-DAQ.

Nodo Elemento di esecuzione del programma. I nodi sono analoghi alle istruzio-
ni, agli operatori, alle funzioni e alle subroutine dei linguaggi di program-
mazione basati su testo. In uno schema a blocchi i nodi includono le fun-
zioni, le strutture e i VI secondari.

O
Oggetto Termine generico che indica qualsiasi elemento sul pannello frontale o nel-

lo schema a blocchi, compresi i controlli, gli indicatori, le strutture, i nodi,
i file e le immagini importate.

Operating Strumento per l’immissione dei dati in controlli che li rendono operativi.

P
Palette Visualizzazione di oggetti o strumenti che possono essere utilizzati per co-

struire il pannello frontale o lo schema a blocchi.

Pannello frontale Interfaccia utente interattiva di un VI. Il pannello frontale riproduce gli
strumenti fisici, come oscilloscopi e tester.
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Positioning Strumento per lo spostamento e il ridimensionamento degli oggetti.

Predefinito Valore preimpostato. Molti VI di input utilizzano un valore predefinito se
l’utente non ne precisa uno specifico.

Pulsante Run spezzato Pulsante che sostituisce il pulsante Run quando un VI non può essere ese-
guito a causa di un errore.

R
Registro dei dati Permette di acquisire i dati e contemporaneamente memorizzarli in un file

su disco. I VI di I/O dei file di LabVIEW e le funzioni possono registrare i
dati.

Riquadro di riepilogo Riquadro all’interno di una finestra di dialogo che elenca tutte le scelte
disponibili per un comando, per esempio un elenco di nomi di file su un
disco.

S
Scala Nel grafico, alcuni controlli numerici e indicatori che contengono una serie

di indicatori o punti a intervalli noti per indicare le unità di misura.

Scalatura automatica Capacità delle scale di regolare l’intervallo dei valori nel grafico. Nelle
scale dei grafici, la scalatura automatica determina i valori di scala massi-
mo e minimo.

Schema a blocchi Descrizione figurata o rappresentazione di un programma o di un algoritmo.
Lo schema a blocchi è costituito da icone eseguibili chiamate nodi e da fili
che trasferiscono i dati da un nodo all’altro. Lo schema a blocchi è il codice
sorgente relativo al VI e risiede nella finestra dello schema a blocchi del VI
stesso.

Segmento di filo Singolo pezzo di filo orizzontale o verticale.

Stringa Rappresentazione di un valore come testo.

Strisce di suggerimento Piccoli banner di testo gialli che identificano il nome del terminale e facili-
tano l’identificazione dei terminali per il collegamento.

Strumento Cursore speciale per l’esecuzione di operazioni specifiche.
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Struttura Elemento di controllo di programma, come una struttura Flat Sequence,
Stacked Sequence, Case, For Loop o While Loop.

T
Task Insieme di uno o più canali, temporizzazioni, attivazioni e altre proprietà in

NI-DAQmx. Un task rappresenta una misurazione o generazione che si
desidera eseguire.

Terminale Oggetto o regione di un nodo attraverso cui passano i dati.

Terminale condizionale Terminale del loop While che contiene un valore booleano che determina
se il VI esegue un’altra iterazione.

Terminale di iterazione Terminale di un loop For o While che contiene il numero corrente delle
iterazioni completate.

Tipo di dati Formato delle informazioni. In LabVIEW, i tipi di dati accettabili per la
maggior parte dei VI e delle funzioni sono quello numerico, di array,
booleano, di percorso, di numero di riferimento, di enumerazione, di forma
dell’onda e cluster.

Traditional NI-DAQ Aggiornamento della versione precedente di NI-DAQ. Traditional NI-DAQ
ha gli stessi VI e funzioni e opera nello stesso modo di NI-DAQ 6.9.x. È
possibile utilizzare sia Traditional NI-DAQ sia NI-DAQmx sullo stesso
computer, cosa non possibile con NI-DAQ 6.9.x.

Trascinare Utilizzare il cursore sullo schermo per selezionare, spostare, copiare o eli-
minare gli oggetti.

U
URL Uniform Resource Locator. Un indirizzo logico che identifica una risorsa

su un server, solitamente sul Web. Per esempio, http://www.ni.com/
è l’URL del sito Web di National Instruments.

V
VI Vedere Virtual Instrument (VI).

VI corrente VI il cui pannello frontale, schema a blocchi o editor delle icone è la fine-
stra attiva.
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VI Express VI secondario concepito per aiutare nelle operazioni di misurazione. Può
essere configurato attraverso una finestra di dialogo di configurazione.

VI interrotto VI che non può essere eseguito a causa di un errore; è indicato da una
freccia spezzata nel pulsante Run spezzato.

VI secondario VI utilizzato nello schema a blocchi di un altro VI. Paragonabile a una
subroutine.

Virtual Instrument (VI) Strumento virtuale. Programma in LabVIEW che modula l’aspetto e la fun-
zione di uno strumento fisico.

W
While Struttura di loop che ripete una sezione di codice fino a quando non viene

soddisfatta una determinata condizione.

Wiring Strumento per la definizione dei percorsi dei dati tra i terminali.
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.lvm, file, 2-9, 2-14
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Abort Execution, pulsante, 1-8
acquisire

informazioni per gli strumenti, 4-7
segnali, 4-1

aggiungere
controlli, 3-4
controlli al pannello frontale, 1-4
indicatori grafici, 3-4
indicatori numerici, 3-4
informazioni visive al pannello frontale, 2-6
input ai VI Express, 1-6, 2-11, 3-4
nuovi canali ai task, 4-5
output ai VI Express, 2-11
spie luminose, 2-6

aiuto
Context Help, finestra, 2-2, 2-13, 3-2, 3-9
Help, pulsante, 2-5

All Controls, palette, 5-2
modificare la visualizzazione della palette, 5-3

All Functions, palette, 5-2
modificare la visualizzazione della palette, 5-3

Amplitude and Level Measurements, VI Express,
2-2
analizzare il voltaggio, 2-5

analizzare
informazioni per gli strumenti, 4-7
nello schema a blocchi, 3-9
segnali, 2-5

Arithmetic & Comparison, palette, 1-9
assistenza tecnica, A-1

nel mondo, A-2
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B
Build Table, VI Express, 3-7

C
canali, 4-2

aggiungere ai task, 4-5
rinominare, 4-5

chiamare un codice da linguaggi basati su testo, 5-6
clienti

assistenza tecnica, A-1
codici di esempio, A-1
formazione, A-1
servizi per professionisti, A-1

Comparison, VI Express
impostare il livello limite, 2-7

collegare
oggetti nello schema a blocchi, 1-7

comunicare
con altre le applicazioni LabVIEW in rete, 5-6
con gli strumenti, 4-6, 4-9

configurazione, finestra di dialogo di, 1-17
Context Help, finestra, 2-2, 2-13, 3-2, 3-9

Show Context Help Window, pulsante, 3-2
visualizzare gli errori, 2-14
visualizzare la configurazione dei VI Express,

2-2
controllare

velocità di esecuzione, 3-6, 3-10
controlli, 1-16, 2-13

aggiungere, 3-4
aggiungere al pannello frontale, 1-4
configurare, 1-16
creare, 3-4, 3-9
numerici, 1-5
palette, 1-4
personalizzare, 1-12
tipi di dati, 5-4
tutti, 5-2

controllo programmatico dei VI, 5-6
Controls, palette, 1-4

modificare la visualizzazione della palette, 5-3
convenzioni utilizzate nel manuale, ix
Convert from Dynamic Data Type, VI Express, 5-5
Convert to Dynamic Data Type, VI Express, 5-5
creare

controlli, 3-4, 3-9
indicatori grafici, 3-4
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indicatori, 3-9
NI-DAQmx, task, 4-2

D
DAQ, dispositivo, 4-2
DAQ Assistant, VI Express, 4-2, 4-9
deselezionare gli oggetti, 1-7
diagnostica, risorse, A-1
documentazione

convenzioni utilizzate nel manuale, ix
introduzione al manuale, ix
libreria on-line, A-1

driver, 4-6, 4-9
software, A-1
strumenti, 4-6, 4-9, A-1

E
Error list, finestra, 2-4, 2-14
errori, 2-14

visualizzare, 2-4
finestra, 2-4, 2-14
lista degli, 2-4, 2-14
visualizzare nella finestra Context Help, 2-14

eseguire, 1-8
senza interruzioni, 3-5
VI, 1-8

Execution Control, palette, 3-5, 3-10

F
FAQ, A-1
fili

eliminare, 1-9
spezzati, 2-4, 2-14

finestre di dialogo delle proprietà, 1-17
flusso di dati, 1-7, 1-11, 1-17
formazione dei clienti, A-1
Functions, palette, 1-9

modificare la visualizzazione della palette, 5-3
funzioni, 5-2

Merge Signals, 1-12, 3-4
tutte, 5-2

I
indicatori, 1-16, 2-13

aggiungere quelli numerici, 3-4
configurare, 1-16
creare, 3-9
eliminare, 2-4
personalizzare, 1-14
tipi di dati, 5-4
tutti, 5-2

indicatori grafici
aggiungere, 3-4
creare, 3-4

Input, palette, 3-2
Instrument I/O Assistant, VI Express, 4-6, 4-10
interfaccia utente. Vedere pannello frontale

L
LabVIEW, finestra di dialogo, 1-2, 2-2
LabVIEW, risorse di aiuto

utilizzare, 3-9
LabVIEW Help, 2-13, 3-9

per cercare i VI Express, 3-3
LED, 2-6
LEDs, palette, 2-6
linguaggi basati su testo

chiamare il codice, 5-6

M
Merge Signals, funzione, 1-12, 3-4
mettere in grafico

dati dai dispositivi DAQ, 4-4
due segnali, 1-11

modificare
pannello frontale, 2-4
schema a blocchi, 2-3
segnali, 1-9, 3-3
tipo di segnale, 1-5
visualizzazione delle palette, 5-3

N
National Instruments

assistenza tecnica, A-1
contattare, A-2
formazione, A-1
sedi nel mondo, A-2
servizi per professionisti, A-1
System Integration, A-1
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New, finestra di dialogo, 1-2, 1-3, 1-16, 2-2
NI Example Finder, 5-1
NI Instrument Driver Network, 4-6, 4-10
NI-DAQmx

creare task, 4-2
provare i task, 4-4
task, 4-2, 4-9

Numeric Controls, palette, 1-5

O
oggetti

deselezionare, 1-7
selezionare, 1-7

Operating, strumento, 1-8

P
palette

All Controls, 5-2
All Functions, 5-2
Arithmetic & Comparison, 1-9
Controls, 1-4
Execution Control, 3-5, 3-10
Functions, 1-9
Input, 3-2
modificare la visualizzazione delle, 5-3
Numeric Controls, 1-5
Text Indicators, 3-7

pannello frontale, 1-4, 1-16
aggiungere controlli al, 1-4
controlli, 1-16, 2-13
indicatori, 1-16
modificare, 2-4
personalizzare, 3-4
visualizzare, 1-8

personalizzare
controlli, 1-12
diagrammi, 1-14
menu, 5-6
pannello frontale, 3-4
schemi a blocchi, 3-9
segnali simulati, 2-3

Positioning, strumento, 1-7
provare, 4-4
pubblicare i VI sul Web, 5-6
pulsanti

Abort Execution, 1-8

collocare nello schema a blocchi, 3-9
Run, 1-4

R
risoluzione dei problemi, risorse, A-1
Run, pulsante, 1-4

spezzato, 2-4, 2-14

S
salvare i dati

in vari formati di file, 5-6
quando richiesto dall’utente, 2-10
su file, 2-9, 2-14

Sample Compression, VI Express, 3-3
Scaling and Mapping, VI Express, 1-9

definire il fattore di scala, 1-10
schema a blocchi, 1-4, 1-1

indicatori, 2-13
modificare, 2-3
visualizzare, 1-5

selezionare
acquisire i segnali, 4-1
analizzare, 2-5
modificare, 1-9
oggetti, 1-7
strumenti, 4-6

servizi per professionisti, A-1
Simulate Signal, VI Express, 1-5
sinusoide, 1-5
spezzato

Run, pulsante, 2-4
fili, 2-4

strumenti
acquisire le informazioni, 4-7
analizzare le informazioni, 4-7
comunicare con gli, 4-6, 4-9
Operating, 1-8
Positioning, 1-7
selezionare, 4-6
Wiring, 1-7

strumenti virtuali. Vedere VI
System Integration, A-1

T
tabelle, 3-7
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visualizzare i dati, 3-10
task

aggiungere nuovi canali, 4-5
NI-DAQmx, 4-9

terminali, 1-7
Text Indicators, palette, 3-7
Time Delay, VI Express, 3-6
tipi di dati dinamici, 5-4

convertire da, 5-5
convertire in, 5-5

V
velocità di esecuzione

controllare, 3-6
VI di esempio

NI Example Finder, 5-1
VI Express

Amplitude and Level Measurements, 2-2, 2-5
assistenza tecnica, A-1
Build Table, 3-7
Comparison, 2-7
Convert from Dyanmic Data Type, 5-5
Convert to Dynamic Data Type, 5-5
DAQ Assistant, 4-2, 4-9
finestra di dialogo di configurazione, 1-17
input, 1-17
LabVIEW Help, 2-5, 2-13, 3-9
Instrument I/O Assistant, 4-6, 4-10
LabVIEW, risorse, 2-13, 3-9
output, 1-17
Sample Compression, 3-3
Scaling and Mapping, 1-9
servizi per professionisti, A-1
Simulate Signal, 1-5

Time Delay, 3-6
tipi di dati dinamici, 5-4
Write LabVIEW Measurement File, 2-9, 2-14

VI, modelli, 1-2, 1-16
vuoti, 3-1

VI, 1-1
controllare programmaticamente, 5-6
creare, 1-1, 2-1, 3-1
eseguire, 1-8
esempi, 5-1
icone, 5-3
modelli, 1-2, 1-16
nuovi, 3-2
personalizzare i menu, 5-6
pubblicare sul Web, 5-6
tutti, 5-2
VI secondari, 5-3
vuoti, 3-1, 3-2

visualizzare
dati dai dispositivi DAQ, 4-4
dati nelle tabelle, 3-7, 3-10
segnali in un grafico, 1-11

W
Web

assistenza tecnica, A-1
servizi per professionisti, A-1

While, loop, 3-6
Wiring, strumento,1-7
Write LabVIEW Measurement File, salvare i dati,

2-9
Write LabVIEW Measurement File, VI Express,

2-9, 2-14
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